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e Automatically write harmonies for up to 6 parts:
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RECORD IMPORT AUDIO CREATE WORKSHEETS FOR YOUR STUDENTS  EXERCISE WIZARD
Add realism to your students work Create a customized worksheet, quiz or Instantly create exercises to improve sight reading,
with a live instrument or vocal track. assignment. articulation and improvisation.

Proudlly distributed by Intelliware
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Practice Made Perfect

Roland's award-winning HD-1 V-Drums® Lite is a big hit with beginning
drummers around the world. Now, the HD-1 just got even better with
the new interactive DT-HD1 Drum Tutor software designed to help
you improve faster. Play along with patterns in a variety of stules, play
interactive games and learn notation. You'll be amazed at how quickly
you progress — and how much you'll enjoy practicing!

Tap into advanced learning with Roland and the DT-HDLI. It's practice
made perfect, where the hardest part is deciding when to take a break!

For more information, visit us online at WWww.rolandcorp.com.au
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FROM THE EDITOR

he focus of this issue is “Technology and Music

Education’, inspired by the success of the January
Music Education in Technology Conference, MTEC was
held at the Wheelers’ Hill Campus of Caulfield Grammar
School in Victoria. Key presenters were the founder of the
Technology Institute for Music Educators in the US, Tom
Rudolph; composer and educator (and co-developer of
O-Generation software), Marcel Pusey; and Australian
trumpeter James Morrison (think: digital trumpet!). Over
200 music educators participated in the conference,
coming from all states, the ACT and overseas.

To build on the interest and motivation generated by MTEC, we have several
articles with a technology and music teaching/learning focus.

Our lead article by James Humberstone challenges teachers to become more
creative in their development of music learning materials. In “Top Tips’ Karie
Wardrobe develops some of these ideas, with great suggestions to help you extend
your use of music notation programs from creating scores for ensembles to
making your own classroom resources. Both James and Katie were workshop
presenters at MTEC. Fiona Phillips appears twice in this issue: first she discusses
the potential of podcasting for music applications in schools and teacher
education, then reviews the Naxos Online Music Library—a subscription service
that give access to the Naxos library of recorded music. In another Top Tips
article, Robyn Holmes (Curator of Music at the National Library of Australia in
Canberra) outlines the many facilities and resources—many of them online—
offered by the NLA and other Australian libraries to assist music educators in
their professional work. This is a ‘must read” article for all music educators!

Under ‘Projects’, Nora Lewis describes how a system of classroom teachers
working with visiting specialist music teachers has made a significant difference in
some Northern Territory government primary schools; and in our ‘Nitty Gritty'
section, experts in teaching modern harmony—Mlichael Griffin—and in aural
training—Deb Smith—discuss some great ideas for you to try out with your
music classes. Henry Vyhnal follows up from his piece in our last issue, with ideas
for implementing a unit of work based on the UK ‘Musical Futures’ approach.

There is an update from ‘Music.Play for Life’, with an important announcement
about the 2009 FLAME Awards. Through the Awards, this year the ‘Music.Play
for Life’ campaign (in association with ASME) is working with the ABC to
conduct a search for schools that make best use of singing to build their students’
engagement and skills in music. So please ‘read all about it” and think about
entering your school for one of these prestigious awards.

As we are all so fully aware, the Victorian bushfires over the past couple of months
have caused great devastation. One of our contriburors, Deb Smith, has initiated
an appeal to replace lost and damaged music resources in bushfire-affected
schools, kindergartens, childcare centres, community centres and other
organisations to help re-establish music as a sustaining aspect of communiry life.
Anyone able to support this cause should check the information on ‘Rebuilding
Communiries through Music’ at www.tinyurl.com/rebuild-through-music.

Another initiative is RESOUND—a tier of the Music Council of Australia’s
National Instrument Bank program. MCA is partnering with the Dandenong
Ranges Music Council to supply donated musical instruments to those who have
lost an instrument in the recent Victorian bushfires—musicians from school
students through to professionals may apply for an instrument.

See www.mca.org.au/web/content/view/323/6

Music in Action commends both of these worthwhile initiatives to readers.

Robin Stevens
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MISSION: TO CHANGE THE WORLD

This major new Australian online resource and showcase aspires to change the musical world by
connecting musicians and educators to a global audience. ANDREW SWAINSTON finds it has real

potential for promoting Australian music education.

The Music Page: www.themusicpage.com.au

The Music Page is an interesting and important
development for Australian music and music education. Set
up in 2008, it's a web resource appealing to a wide cross-
section of musical interests, backgrounds and age groups. It
has immediate relevance for Australian music educators
and music students alike, with a strong focus on
instrumental teaching, programs and performances. It is
already attracting a national audience and membership.

The site's 'about us' page explains its mission is no less than
to 'change the musical world by connecting musicians and
educators to a global audience.' It aims to achieve this
through dedication to two propositions:

1. The world's best performances should be available to
anyone, anytime, anywhere—over the Internet.

2. The best in music education should be available over the
Net, to anyone, anytime, anywhere, from the world's best
teachers!

To this end, The Music Page offers an extensive and
growing

* online video library of world-class music performances

* repository of high quality, video instrumental lessons,
tutorials and lectures by Australian and international
teachers.

As far as | am aware this site is unique in several important
respects.

Learning Zone

Here are instrumental video lessons, tutorials and
performances (presently 73), from musicians such as
Hector McDonald, (horn) Zoe Knighton and Jospehine
Vains (cello) Rex Richardson (trumpet) and Lin Jiang
(French horn), to mention just a few.

Showcasing school instrumental performances

A stand-out feature of The Music Page is the extensive
range of video clips of performances by Australian school
music ensembles, including concert bands and orchestras.
We can expect that more schools will soon be getting on
board. In the 'Learning Zone' section alone there are over
70 videos of school band performances from about 50
schools, performing a wide range of repertoire at a broad
cross-section of school and community events and
concerts. You can't help being struck by the quality, breadth
and depth of what is on display.

Itis a significant development for music education
advocacy to showcase all this, giving easy access by school
communities—including parents—as well as education
departments, their ministries, and others with an interest in
music education. Another crucial factor is that this is an
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excellent way to share ideas and medels of good practice
among teachers in schools and other settings. It is also
inspiring for young musicians to see their own music
performances, and those of so many others, being
celebrated in this way. This is really ‘the heart’ of The Music
Page. | recommend that you look for yourself!

‘On Demand'—a library of the best

As mentioned above, The Music page already has an
extensive video library of over 500 high quality
performances covering a range of genres—mainly,
although not exclusively, in the western classical and jazz
traditions. These include some of the world's best solo
musicians, ensembles, bands and orchestras.

Join an online community

Highly worthwhile is the call to build an online community
of music educators and musicians. You are invited to join
(free) and contribute—for example, by sharing ideas and
uploading items for the library content. The clear intention
is to grow and deepen the solid base of engaged and active
members. Once registered you can 'create your own space
to connect with others in our highly engaged and active
online community. Interact via forums, live chat and
comments and undertake various activities including self-
promotion and discussions'.

Future directions

Although still in its formative stages, The Music Page has
had considerable thought and work put into its
development. The site's layout and appearance have been
very professionally designed. Navigation is easy; a
welcome technical feature is the high resolution of the
video clips, which can stream at lightning-fast speeds.

Perhaps more resources appropriate to classroom music
might be included. | would also like to see a 'links page' to
extend the outreach of this site. To a large extent, future
development will depend on the contributions of the
membership. As this site grows, and with some strong
promotion, it no doubt will attract attention internationally.

The project appears to have significant backing, with a
Board of Directors that includes Geoff Collinson (founder
and managing director), current and former business
leaders and the highly respected French horn soloist Barry
Tuckwell. Hopefully this will ensure its success as a
valuable and informative resource for music teachers and
students alike. M/l

E-connect: For shortcuts to some of the listings that
caught my attention, including some off- beat items that
would be fun to use in the classroom music context, go to
the Music in Action website:
http://www.musicinaction.org.au
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The first USB keyboard controller with a built-in

audio interface and premium piano sound.

+ all-in-one solution with semi-weighted
velocity-sensitive keys

« instant access to piano sounds

+ 128 GM sounds plus drums &
percussion

+ line and mic inputs

« available in 49, 61 & 88-keys

Education pricing for 10+ units

A very affordable USB MIDI keyboard. M

« professional feel & response -*‘E"p

« includes KeyRig software for PC \@
with pianos, synths, organ & more \

+ USB 2.0 and USB 1.1 compatible

+ includes Ableton Live Lite (PC/Mac) software

- available in 25 & 49 keys

Education pricing for 10+ units

MicroTrack [l
A professional, high-fidelity mobile
digital recorder.

« 2-channel WAV/MP3 recording & playback

« perfect for field recording, songwriting,
training & education

- balanced %" TRS inputs with line inputs and
48V phantom-powered mic preamps

Education pricing for 5+ units

Includes features the top studios use to produce
award-winning albums and film scores.

- session compatibility with all current Pro
Tools systems; hardware compatible with
two dozen M-Audio interfaces

- Elastic Time tempo manipulation

- includes over 30 plug-ins, Structure™
Free sample player and Xpand! virtual
instrument

Education pricing for single and 5-user lab packs

ﬂ digidesicmn

2 Mini Educational

MBoxes are "standard issue” for learning
or teaching audio skills for music
composition, production, and audio
engineering. All MBox 2's include
industry-standard Pro Tools software.

MBRAv 27 2 MBRAy
MBox 2 & MBox

- compact, USB-powered Pro Tools
LE audio workstation
+ delivers high-quality sound, with
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Sibelius is the fastest, smartest, easiest way to
write music and by far the most widely used
scoring software in Australian education. The
best possible solution for senior music students
and teachers.

+ 2000+ musical ideas to inspire students
+ new, easy-to-use, Licence Server
« more realistic playback of scores
with Sounds Essentials included
+ VST & Audio Unit support
+ new World Music, Choral and Rock
& Pop sound libraries available

Education pricing for schools and teachers,
secondary and tertiary students, and site licenses

vibelius Student

Sibelius Student is the ultimate tool for doing
middle school level music homework.

+ powered by Sibelius 5, but a fraction of the
price

+ students can exchange files with Sibelius 5

- students can email scores to teachers from
within the program

Minimum order of 20 copies. Available to
students through schools with 5 or more
multi-seat (full version) Sibelius licenses

Groovy Mus

Teaching and learnlng music in primary school
has never been so much fun! Groovy Music

is a series of three programs that

students simply love. Clear and

well-written materials to support
non-specialist and specialist

teachers are included.

Available in Primary Pack Single
(Groovy Shapes, Jungle & City plus
Sibelius Starclass & Instruments) and site licenses

pinnacle

s Version 12

Combmlng power and simplicity,
Pinnacle Studio Plus 12 video editing
software lets you take control of the
latest HD video technologies and
quickly transform your videos and
photos into amazing movies.

:

s.tudia P

Site and notebook licenses available

75 For more information phone 1300 652 172
) Order at www.sibelius.com.au

mutliple I/O © 2008 Avid Technology Inc. All rights reserved. All prices are for Australia only and are
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availability are subject to change without notice. All trademarks contained herein are the

. property of Avid Technology Inc. or its subsidiaries in the Unities States and/or other countries.

Education pricing for 10+ units
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THE CREATIVE TEACHER

How to use technology to produce learning materials

JAMES HUMBERSTONE outlines some great ideas for producing music learning materials, using a

range of technologies.

bout ten years ago I was looking at a new publication—a

collection of music lesson plans in PDF formac with the
music embedded'—which cleverly used the technology to
link different lessons and resources. When I asked a colleague
and friend what he thought of it he said it was very good, but
that there is no resowrce like the one you make yourself.

As teachers, we all know this to be true. We might love Listen
to the Music or Music: Lets Do It/2, burt the best lessons we
teach often are based on repertoire we know backwards, or an
original idea for a classroom performance or composition
project, or content adapted from great text books and
delivered in our own style, drawing on our own teaching
strengths.

Over the years I have not only appreciated this advice, but
have come to realise that as we become more competent with
technology, we creative teachers can actually author our own
teaching materials and resources to a very professional
standard—and the act of producing resources is engaging,
creative and fun. Sure, it can take a long time to produce all
the resources for a unit of work to the high standards we
demand, but che time invested will also ensure the longevity
and qualicy of that unit for the future.

In 2009 I find myself publishing in many ways, and pushing
myself to acquire new technology skills so I can achieve
bigger and better things. The following are simple ideas that
you can begin with, then develop to match higher-level
content you might dream up.

Online learning resources—delivering lessons
from a web browser

All of the content described here is framed by its delivery
model. At MLC School, Sydney, our intranet allows teachers
and students direct access to several resources that can be
delivered as online units. Students don’t just download the
resources, though. Rather, they discuss the content of the
lessons, contribute to blogs about the creative processes they
use, and upload work in progress for teacher feedback.

I've also taught at schools that don't have this infrastructure.
In such circumstances, you have to be even more creative—
for instance, by using a web authoring program (there are
plenty of simple free ones available) to create pages of HTML
with linked images, audio recordings and movies, and asking
your network administrator to upload them for you. If they
can’t help, look at a free site, such as www.edublogs.org, then
present your principal with both solutions and work around
the privacy issues. However, do be mindful of the copyright
laws.3

Embedding technology

Technology can be used in all aspects of the music
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curriculum. Traditionally, students have used technology
mostly to compose, because sequencing programs such as
Cubase or Cakewalk make it easy to capture ideas, while
notation programs such as Sibelius, Encore etc. make first
compositions look complete and professional—as well as
providing aural feedback (though this has its problems).
Technology also can be used in performance—whether
simply to capture students’ work for later reflection (we
record all performances during each lesson and share them on
the intranet so that students can reflect on them later); to
accompany students using MIDI files, backing tracks, or
specialist software like StarPlay or SmartMusic; or to teach
group performance through exciting software like
O-Generator World Music. And technology can be used to
play back repertoire in listening lessons, to develop aural
perception with specialist software like Auralia, and so on.

A sample unit of work using technology

The creative part is to use the technology to move seamlessly
berween these different learning experiences. An example is a
unit of work I've been teaching recently to middle school
students:

Fig. 2. ... then perform it in two groups.

After a few weeks of practising the piece, we reflect on the
metre changes and, depending on the level of the class, I
might introduce the concepts of simple and compound time.
We extend the listening by watching a video clip of ‘America’
from West Side Story. The technology comes in here, first for
delivering the video clip, then for repeated playing back of
‘SixEightThreeFour’ in GarageBand or Sibelius, depending

on the musical literacy level of the class.

From improvisation to composition

Students can improvise with this backing track on keyboard
instruments or xylophones. We discuss which pitches work
best and identify the tonal centre; then we work on laptops or
in the music lab where the scudents record their
improvisations in Sibelius or GarageBand; and in the act of
selecting their best performances and editing some notes,



Next we learn the simple piece? on xylophones and untuned or body percussion.
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Fig. 3. ‘SixEighcThreeFour’

they make a seamless move from improvisation to
composition.

The files provided for the students to compose with are
provided as templates with all the accompanying parts. Once
the arrangement is entered into Sibelius, it can be exported as
a MIDI file and imported into GarageBand or any other
sequencer.

Matching the software progression to the sequence of
musical concepts

Students can follow a progression of complexity in musical
content by gradually learning more features of the software
and using more advanced software. For example, students
may begin by using a looping program like Acid or
GarageBand to ‘audition’ sounds and arrange them in
different combinations. There is value in this simple
experimentation because the students are actively learning
about the elements or concepts of tone colour, texture and
structure. Further along the learning progression, [ want
them to gain the ability to compose loops (effectively,
ostinatos themselves—how to input and record sounds using
a MIDI keyboard or a step sequencer. (O-Generator is the
easiest, and for older students Fruity Loops and Reason? offer
endless possibilities.) I always begin with rhythm (drum beats
in different styles) because students don’t need to have
knowledge of harmony to move forward quickly.

The next extension is to engage with notation. Students don’t
have to start with traditional notation—they may begin by
writing notes in a matrix editor in their favourite sequencer,

= O-Generator

Libepi » GarageBand Fruif
s:.mm : Lon;);
* Reason

which is really a form of graphic notation, and quite easy for
a student who has used a step sequencer to understand. After
that, progress to notation software—although at this point

I tend to get ‘old fashioned’ and ask students to handwrite
their music. Why? So I can see that they can hear in their
minds the music they've been composing, rather than to rely
on the software’s playback to give them an approximation.®

Application features to extend your resources
With this progression in mind, how can we make useful
learning resources of our own rather than just use the simple
templates referred to in the sample unit above? The answer is
to become more knowledgeable about the software that we
use.

Loop-based composition projects

We can extend the use of looping software like GarageBand
or Acid by creating our own content. For example, in a Year 8
unit I'm teaching, students learn to play the piano riff from
the opening of a song called “When Doves Cry’, and then
perform it with a series of covers (have a look on the i'Tunes
library—you'll find a version in just about every style
imaginable, from bluegrass to Latin to heavy metal). It’s then
time to make their own version. ['ve created a collection of
loops in different styles using the same chord patterns, so
they can begin by putting them together to create a template
in a style they like. Later in the course they'll analyse how a
beat is put together in the style they have chosen, and create
one for themselves as well as improvise new melodic content

+ Sibelius
= Finale

Marrix
editor/

sequencing

Fig.4. A parallel progression of software complexity and musical skills.
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over the top with a MIDI keyboard.

You can make your own content for both
Acid and GarageBand relatively easily. In
Acid, record each new loop using a
MIDI keyboard and a soft synth (even
the free

version, Acid Xpress, will do this now). ——
Make sure that you play in time with the | _##
metronome. When you're happy with
your new loops, render the file using - [

——————- .

(&) . ideas

| Score

] Horn Tune

'3

78

\ﬁ%iint.unerising
B R =

‘File > Render’ (that is: if you have
created several MIDI tracks, you can
choose to ‘render’ each track as a separate
file). This process turns your MIDI data
into audio files.

Once the files are rendered, select them
again in Acid’s file explorer, then choose
“View > Clip Properties’. In the ‘Clip
Properties’ dialog, the root note and the
number of beats should be detected
correctly—if not, you can edit them
yourself. If you do make changes, simply
click the ‘Save File’ button at the top
right. Keep all of the loops together in

Fig. 5. The Ideas Hub in Sibelius.
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the same folder and you can share them
easily wich your students.

In GarageBand the process is similar. Record your loop in a
‘Software Instrument’ track, then highlight it and choose
‘Edit > Add to loop library’. A dialog box similar to the one
above will appear, with settings based on the current project.
You can easily make duplicates of the loops, but in different
styles, by changing the instruments and effects. These loops
are automatically added to your own loop library bur to share
them with students you'll find them all in your home folder
under ‘Library > Audio > Apple Loops > User Loops’.

Step sequencing

Lessons are built into O-Generator: Use them, and extend
the same concepts into Fruity Loops or Reason or any
sequencer with a matrix editor.

Notation composition projects

If using Sibelius, the key to delivering great composition
resources is to use the Tdeas Hub.” If you have Sibelius 5, you
can open this feature by going to “Window > Ideas’. You'll
find a library of hundreds of musical ideas with a notation
preview that will play back when you click and hold them.
You can search for different ideas by keywords (for example,
‘hip hop drums’, or “film music’). Its like a loop browser for
notation software.

As with the loops provided in Acid and GarageBand, these
ready-made ideas have a limited shelf life. However you can
capture your own ideas by highlighting the music you want
to provide for students and clicking the ‘capture idea’ button
or keying Shift-I. You can also turn off the Library provided
in your template files by going to ‘File > Score Info’ and
under the ‘File’ tab tick ‘Show ideas from this score only
In Sibelius, you can also turn off the Library permanently
under ‘Preferences’.

k]
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While Finale doesn’t have chis feature, you can of course
create Finale templates with material in them, to open in
different windows.

The power of this template facility is enormous—you can
provide students with just the material they need to get them
started (avoiding the ‘blank page’ syndrome)—but do not
distract them with superfluous material. As the simplest task,
you could break a melody up into pieces and ask them to put
it back together. And for a more complex task, create files
that link to the repertoire you've been studying, wich key
elements included in the ‘Ideas Hub'. T created a series of
these files for an Australian Music Centre education kit
released recently called Stepping Stones.

MLC sharing

Samples of similar files are downloadable from my website or
can be found as shared resources on the Apple Learning
Interchange.” Sharing is an important part of the MLC Music
Department’s policy, following successful outreach projects to
Broken Hill and Mungindi over the past few years. We've just
joined the Soundhouse Association, and having become an
accredited Sibelius Training Parcner, will be providing
professional development courses this year. In addition, we're
developing a new website for our Australian Music Day this
year to allow students anywhere to follow the composition of
a new Australian work, and to interact online with the
composer, Andrew Schultz.®

The MLC online unit model described above is now being
expanded beyond our intranet as part of a new project called
‘Skoolaborate’, which incorporates cutting-edge virtual-world
technology. With chis new ‘global’ model, teachers in any
country will be able to subscribe to units of work for use in
their own classes. 10



More creative sources
These examples are a few of the ways that technology can

allow teachers to become publishers of their own work. We
might also consider the possibilities offered by collaborative
online research projects using Wikis, assignments handed in

as Podcasts, the integrarion of basic audio editing skills to
students’ perﬁ)rmance work, the making of multimedia
worksheets for students, and so on. This is the kind of PD

we'll be aiming to provide at MLC. It’s so much fun and the
sense of achievement from creating something great is, for me

at least, akin to one’s first performance, improvisation, or
composition. [/

James Humberstone

Notes, resources and contacts
1. Sibelius Starclass

2. I Dorricot, Listen to the Music, fifth edition, McGraw-
Hill, Sydney, 2007.
B Rixton & B Merrick, Music: Lets do it!, second
edition, Science Press, Marrickville, NSW, 2006.

3. For a summary of education copyright information, see:
www.smartcopying.edu.au

I8

. From Symphony of the Child, by James Humberstone,

written for Sydney’s International Grammar School, who

will premiere it at Angel Place, Sydney in May.

. This is not an exhaustive list of software titles, so it’s
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James Humberstone is composer-in-residence at MLC
School, where he is also co-ordinator of the
composition programs in stages 1to 5. James draws on
previous experience as director of applications and
education at Sibelius Software in his work at this 1-to-1
Apple school and also lectures in music education and
technology at the University of Western Sydney. As a
composer he is interested in writing music with
integrated programmes of learning that can be easily
embedded in schools' curricula: this is the focus of his
PhD research at the University of New South Wales
and recent children's opera Kiravanu
(www.kiravanu.com).

E-CONTACT

James Humberstone:
<jhumberstone@mlcsyd.nsw.edu.au>

“Opportunity for piano teachers
to become an agent for
Piano Time products”
Contact John 1800 282978

www.pianotime.com.au info@pianotime.com.au

Ph 1800 282 978 or 03 96903444

6.

7

8.

9.

important to recognise that the distinction between
looping software and sequencers has become blurred.
Both types have shared features, but it is useful to first
consider the simplicity of the original looping programs.
Similarly, some sequencers include step sequencer plug-
ins, and Reason itself is not limited to step sequencing,
The software titles mentioned are those of which I have
firse-hand experience.

For more ideas on how software and hardware can be used
in the classroom, see Andrew Brown’s recent book
Computers in Music Education: Amplifying Musicality,
Routledge, New York, 2007.

Access is at www.composerhome.com and at Apple
heep://ali.apple.com/ respectively.

For details, see MLC School Soundhouse:
www.mlcsoundhouse.com

MLC Australian Music Day: Watch for the new website at

WWw. ll'llCSyCl .NSW, f:dll. au

10. MLC Skoolaborate: www.skoolaborate.com/ For more

information, contact Westley Field, MLC Director of
Online Learning, at <wfield@mlesyd.nsw.edu.aus.

AUTUMN SUBSCRIBER PRIZE WINNERS
The 15 winners of the ‘CLASSICAL DESTINATIONS'
BOOK/DVD PLUS 2-CD SET were;

Gib Gate, Mittagong, NSW; Lyn Lockrey, Mooree, NSW; Nita
Lawrie, Yagoona, NSW; llona Retallack, Noonamah, NT;
Rhonda Wood, Buranda State Primary School, QLD; Robyn
Edgar, Shalom College, Bundaberg, QLD; Frances Dennis,
Athelstone, SA; Melinda DeConne, Gleeson College, SA;
Tony Vance, Christies Beach, SA; Carol Samuelson,
Blackmans Bay, TAS; Wendy Ross, West Hobart, TAS; Kay
Derham, Carrington Primary School, VIC; Mary-Anne Allen,
Dandenong High School, Cleeland Campus, VIC; Judith
McCullough, Mt Lawley, WA; and Sue White, Warwick, WA.

THANKS to Hal Leonard Australia for their generous
donation of this prize, and to our new subscribers for
helping to keep Music in Action going.

MUSIC in ACTION



REVERSING THE TIDE IN THE TOP END

Responsibility for primary music has been increasingly left to generalist teachers, yet NORA LEWIS
outlines how a system of classroom teachers working with visiting specialist music teachers is making
a real difference in some NT government primary schools.

he Northern Territory Music School delivers a variety of
music education services across the Territory, with 21 staff
working in the Darwin/Palmerston area and 7 in ather
regions of the NT—not many for 771,747 square kilometres!
A unit of the Northern Territory Department of Education,
our core business is to provide a program of instrumental
music teaching and development of performance ensembles
using the ‘Band Approach’ method through the ‘Standard of
Excellence’ curriculum,’ and choral teaching focusing on an
annual multi-arts program with a massed primary schools
choir. Over the years the Music School’s work has expanded
and diversified to encompass an array of activities:
e provision of a Middle School class music program at a host
school using SMART Board interactive whiteboard
technology
validation and moderation of Year 12 student performances
in senior secondary schools across the Northern Territory, as
part of South Australian Certificate of Education/Northern
Territory Certificate of Education Stage 2 course work
coordination of touring artists, such as those in the keenly-
appreciated annual Musica Viva in Schools music education
program
writing and publication of practical classroom music
education materials, such as in the Lynx Project.2
provision of teacher professional development and
mentoring—in these materials and in specific areas, such as
singing through the ‘Music. Count Us In” project, and the
South Australian-linked choral program
ongoing visit-teaching in remote Indigenous community
schools, particularly in support of senior secondary
Indigenous music students
workshops in performance skills and music technology for
students from all over East Arnhem at the annual Garma
Festival
emerging use of Interactive Distance Learning (IDL) for
instrumental music lessons from our recently-completed
video-linked studio
music camps and festivals
partnerships with other agencies, such as The Songroom
and The Smith Family.

As in any work unit, these activities involve growth spurts
and plateaus according to staff skill and energy, client
response, availability of resources and support; bur on the
whole we have been excited by the enormous opportunity for
involvement at numerous levels. One innovation is our Year
3/4 classroom music program that was trialled last year in 13
schools around Darwin and Palmerston. I highlight it as
much for its potential as for what has so far been achieved.

Most of our work over the years has been in response to
student or staff requests for, or interest in, music teaching.
Sure, we have sought out likely students, canvassed interest
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through various means, encouraged participation and
vigorously followed up faltering application, as we all do in
music education! But on the whole we have met the interests
and needs of those who have opted into our services.

The Year 3/4 class project is a departure from the norm. After
obtaining consent and consulting with teachers, two
members of our music school have entered the classrooms of
750 children who have never asked for music lessons and
wouldn’t have known what to expect!

This program resulted from the alignment of several factors:

a) recommendations from the National Review of School
Music Education calling for provision of a developmental
music education for all primary school children, and the
realisation that in the Northern Territory, this might best
be provided by specialist music school staff (rather than by
generalist teachers), even within a limited scope;

b) the emphasis of the National Review on the importance
of, and accessibility to, singing in schools;

¢) South Australia’s stated intention to trial a whole-class
(although not class band) approach to Year 5 instrumental
music education, which seemed to macch our thinking;
and

d) the presence on staft of two teachers well suited to whole-
class work—guitarist Stephen Duff, who easily involves
children in singing with movement, and Julie-Anne
Watson, who is a woodwind player and winner of a
National Award for Excellence in Music Education last
year as a classroom music specialist.

Several schools expressed interest in participating in the
program in 2008. Our aims were to deliver weekly classroom
music lessons to children in 28 selected Year 4 classes, at no
cost to schools, and to develop aural and musicianship skills
through singing, playing the recorder and (although not
proceeded with) the ukulele. Although there was an emphasis
on practical participation and enjoyment, music reading—
including music theory—was included. One of the intended
outcomes was that these children would be better prepared
for whole-class instrumental learning the following year. The
only condition was that teaching would occur only in the
context of the generalist teacher’s willingness to engage at
every level of the program.

Although the two Music School teachers designed the lesson
program for congruent implementation, they employed
different methodologies and operated fairly independently.
Stephen’s approach was mainly through oral/aural
development, by gently attracting students’ interest to singing
through his guitar accompaniments, developing a repertoire
of favourite songs, linking singing with group rhythmic work,
and teaching the recorder with a ‘copy me’ approach before



introducing any notation. Julie-Ann, while equally
comfortable in promoting singing, focused more on teaching
notation through the recorder and rhythm games, aiming to
develop students” musical independence.

Both teachers proved themselves highly effective in bringing
music into classes that otherwise had not experienced it, and
worked hard to bring the generalist teachers along on the
learning journey. While most of these teachers responded
positively, enjoying their students’” delighted engagement and
embracing some mentorship offered, others were more
reserved, seemingly daunted by the unfamiliarity of the
subject, the amount of preparation needed, and the
challenges to familiar notions of classroom control.

The students’ response was universally enthusiastic. Several
teachers reported that children viewed their music lessons as
‘the high point of their week” and eagerly anticipated them.

Before f:mbarking on similar work this year, we reviewed the

program to evaluate its impact and effectiveness during 2008,

and made some interesting although not surprising

discoveries. Honest discussion revealed some weakness

such as:

= insufficient consultation with some host schools, leading to
a lack of"clarity over intended outcomes of the program and
litcle real ‘ownership’ by the schools

* lack of explicit student assessment targets, including
performance targets

e insufficient time for joint planning to allow for inclusion of
the music lessons as part of an integrated unit of work, for
follow-up, and for team teaching with music school staff.

However, many positive aspects were identified. Students said

they enjoyed:

* learning new songs—old and new, happy and sad, and
songs in other languages

* singing together, sharing thoughts about music, ‘hearing
other people’s noise’, having fun

* copying and echoing in the call-and-response songs

e the teacher bringing different inscruments to class that chey
had never seen before and being allowed to touch and play
them

e learning how to play recorder.

Many students said they would like music classes twice a

week!

As a result of the program, classroom teachers found that
they experienced:

reduced fear of participating in music activities, especially
singing, and feeling more willing to ‘have a go’, to sing
along with children and to play the recorder

increased confidence to ‘allow’ children to participate in
active music-making in class, despite the risk of noise. Some
even demonstrated increased confidence and competence to
include music in a weekly classroom program

e new understandings of music theory.

Although significant progress in music literacy had not been
made for all students, what did emerge at all schools was a
positive impact on students” well-being. Well-being is an area
of specific accountability for all Northern Territory school

principals (and I suspect nationwide), so schools embrace any
program that benefics children in this way. The music
teachers” encouraging attitude and level of engagement with
every child in the class was mentioned by many partner
teachers as having a noticeable effect on their students’
confidence in speaking up within a group and sharing
together. Also reported on was the effect of song repertoire on
children’s emotional experience and ability to express a
response, especially in classes with high ESL presence.

This year the program is continuing, with closer consultation
berween the music specialists and the classroom teachers, and
the setting of specific levels of attainment for students.
Implementation of these, with small-scep assessments, should
provide further evidence of the rich music and more general
learning taking place through the program. As a result of the
Year 4 class program, at the end of the year over 150 students
expressed interest in learning an instrument in Year 5—a
marked increase over other years.

Although perhaps ‘swimming against the tide of history” by
re-introducing specialist teachers into government primary
schools?, the Northern Territory Music School is
demonstrating both the musical and the personal well-being
benefits of teaching music by involving specialist music
educators in government school settings. Min/A

Notes
1. The ‘Standard of Excellence’ Series of ‘method books’ is

authored by Bruce Pearson and published by Neil A Kjos
Music Company.

2. The Lynx Project, developed by the Music Advisory

Support Team at the NTMS, provides arts-based
professional learning opportunities for generalist
teachers, including interactive school performances with
literacy and numeracy outcomes and a resource kit with
detailed strategies for planning, implementing and
evaluating arts learning.

3. In the late 1970s, for example, the Music Branch in

Victoria and its ‘field force’ of 90 visiting music
specialists was disbanded.

five years before moving into music advisory work in
the Education Department. She then took over

Nora Lewis

Principal of the Northern Territory Music School, Nora
Lewis first went to Darwin in February 1978, teaching
music, English and humanities at a local high school for

leadership of the instrumental teaching team, until the
‘Music Centre' became the Northern Territory Music
School, combining several programs and delivering a
range of music education services.

E-CONTACTS

Nora Lewis: <nora.lewis@ntschools.net>

Northern Territory Music School:
www.schools.nt.edu.au/ntmusic/
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THE PODCASTING NET

Podcasting has become a powerful modality for music teaching and learning. From her own experience
of the technology, FIONA PHILLIPS outlines and advocates its use in music education generally.

he growth of podcasting as a popular means of

disseminating education content has led some schools and
universities to look at providing iPods or their equivalent for
students.

However, the real power of podcasts for learners is when the
pupils become producers as well as consumers. Alexandre
Bonucci, who is in charge of Information Technology (IT)
and Information Systems at Université Lumiere Lyon 2,
suggests: [eaching used to be about teachers delivering
content to passive students. Now teaching is much more
interactive, an act of common construction berween teacher
and student using the media.” Technology having a high
perceived ‘cool’ value can be used to engage otherwise
disaffected pupils. Podcasts produced in small groups
encourage collaborative learning and teamwork, while the
tasks of producing podcasts also improves literacy through
researching and writing the script—topic knowledge is
imparted almost by stealth. Recording audio develops oratory
skills and builds confidence, especially if students’ podcasts
are distributed to an audience wider than class peers, and
where positive feedback is encouraged from che listener.

There are many opportunities for using podcasts to
supplement normal teaching. One possibility that is
particularly useful in music is to sing and discuss music
examples in the aural mode. I am sure many of my students
in the past have asked, ‘How did that song we sang last week
go, again?” Now I have the means to be able to answer that
question in the best possible way—aurally.

Casting my net

I decided to trial podeasts in teaching ‘Young Children’s
Movement and Music’, a subject in the pre-service Early
Childhoed Education (ECE) course at Deakin University,
mainly because much of the material in the prescribed text
was aural in nature—songs and melodies—and although the
material appeared in conventional staff notation, I was
certain that for a high proportion of students this would be
of little help. Throughout the semester, I ‘pushed out’ a ‘Song
of the Week’ podcast with suggestions for rehearsal
technique, vocal style and accompaniment ideas. I also used
the podcast to highlight the key points made in class. and to
present extended discussion about them. I could add to or
edit the podcast, include interviews with external music
educartors, add to or reinforce the material, and underline
examples of good teaching practice. In addition to receiving
this sort of information about the content of the unir,
students were given the skills and opportunity to produce
their own podcasts in the form of audio books, songs and

arrangements of songs, interviews and discussions, which
developed their oral skills and enabled them to share their
musical and other ECE experiences with others.

To gauge the potential of podcasting as supplementary
material, I undertook an evaluation of the subject, delivered
both as an off-campus mode with two 3-hour ‘intensives’,
and as an on-campus workshop. I chose to release weekly
podcasts that supplemented the classes and reading materials,
rather than just record the sessions.

First, I surveyed students to find out what access they had to
digital audio players, and if they had any experience with
podcasts/podcasting. | found that 65% of the students had a
portable device, and that 75% regularly listen to audio on a
computer. Those that had portable devices estimated that
they spent an average of 7.6 hours per week listening to
them, and 15% reported listening to them for 10 or more
hours per week, The most popular situation for listening was
while walking (33%), but other activities were popular too—
including while travelling on the bus and in the car (21%
each), while exercising (15%) and on a bike (10%). Only 5%
of the students had listened to a podcast before, and only two
students in the class reported listening to podcasts daily. This
could be a reflection of the age range and distance from the
perceived ‘net generation’ of these scudents, coupled with the
lack of adoption of podcasting in Australia due to relatively
high charges for Internet use and lack of broadband width.
Despite the lack of experience with podecasts, 85% of the
students reported that they intended to listen to the first
podcast.

All students taking “Young Children’s Movement and Music’
had access to the weekly podcasts. The podcasts ranged in
length from 5 to 15 minutes and took the general formar of:
a welcome comment, ‘song of the week’, musical ideas for the
song of the week, last week’s song and a review of the material
from the past week, topics coming up later in the subject,
reminders of any deadlines and discussion about current
topics, especially if they related to current events—
community arts events, concert dates, etc. Some included
sections of the prescribed text read aloud, with additional
commentary and/or aural example sung or played.

The podcasts were recorded using digital audio editing
software—mostly ‘GarageBand’ or ‘Audacity’—and used both
inbuilt and studio microphones. Interviews often were edited
into the podcast, along with excerpts of songs or music.

The podcast genre typically has a ‘live’ style, with minor
glitches left in the recording. Recording in one rake makes
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LECTURES TO GO

Australian universities have been making lectures
available as streaming audio for a few years now, albeit
with learners anchored to a computer in order to listen,
due to lesson length and content. Creating a Podcast,
then downloading to a mobile media device (e.g. iPod or
other MP3 player) has allowed students to take lectures
and other audio wherever they go. Students can listen
and re-listen to content while they are exercising, riding
the bus or simply taking a walk. However, this
‘coursecasting’ or 'profcasting’ model still relies on the
top-down structure of lectures, as academic content for
students to consume. This is not the podcast model that
I'wish to fish with. | say 'fish with* because | envisage the
podcast as an innovative way of capturing the attention
of students taking my units. Finding the right hook and
bait can be difficult in'this very rich media stream, and |
am not sure when the students in my classes are
swimming, like salmon, against the stream, or are more
likely to be ‘going with the flow".

Benefits of podcasting

» frees students from the constraints of the physical
classroom

assists students studying in a distance education mode

moves towards an ‘on-demand' teaching material
model

enables students with lower traditional literacy skills to
participate in/learning at all levels

makes it easier to integrate learning material from
external experts

engages learners

promotes personalisation and collaboration

uses a familiar interface, medium and equipment for
‘net gen' learners

relies on readily-available access devices—a portable
media player or web browser

requires a relatively small investment in start-up
equipment

utilises intuitive software for creation—for example,
iLife frem Apple

requires a relatively low level of technical skill to begin
podcast production

availability of free open source editing and distribution
of software

automates dissemination of routine information
frees up time for tutorial work

opens new channels of communication for students
and teachers

builds literacy and oratory skills, confidence and
teamwork

enables students to review lesson, tutorial content
without taking verbatim notes.
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creating the podcast much less effort, and gives a personal
and dynamic feel to the episode. Podcast recording
software such as ‘Castblaster’ and ‘PodProducer’ (both for
Windows only) assume this ‘one-take’ mode of operation,
whereas editing systems such as ‘Audacity’ and
‘GarageBand’ (for Windows and Mac respectively)
encourage editing of the content. I found that interviewees
were often a little nervous as it was a new experience, and
in these cases the offer to edit out any hiccups was greatly
appreciated.

Feedback from students indicated a small but significant
group with almost no interest in this mode of learning.
However, for those who regularly used the podcasts, the
feedback was extremely positive—including comments
such as ‘Great idea—keep it up!” and ‘Nice addition to
study material and I loved hearing the songs again’.

Podcasting in music education settings

My evaluation of podcasting in this ‘music and movement’
subject indicates that it can be a low-effort and effective
supplement, but not a substitute, for traditional teaching.
I had cast my podcasting net and managed to ‘trap’
(benignly) quite a few students who were swimming in the
mult-modal stream of ICT (Information and
Communication Technologies). Students who used the
podcasts greatly appreciated them, and many of those who
had not accessed them indicated that they thought it was
potentially a useful and interesting resource that they
intended to access ‘later’. The ability that students had to
be part of content creation and step up to the ‘iPodium’
was beneficial for all involved. For my ECE students,
podcasting was far more than a content-delivery
mechanism; it was part of their ongoing participation in
knowledge communities, in tertiary settings and beyond.
Student podcasting also made content creation possible for
all, and was part of the process of helping learners develop
the tools of cultural interaction, not just consumption,
which are increasingly part of an essential digital literacy.

Unexpectedly I discovered that the students” listening and
oral skills were further developed. Skilled listening is the
foundation of any musical activity and such a skill cannot
be taken for granted by music educators. Different listeners
may come to different conclusions about and
understandings of the same piece, depending on their
musical experience and cultural background. The skill is
governed by context and requires active involvement and
musical thinking on the part of the listener.

By engaging in the initial listening and then responding in
an aural mode, the students were able to state their
position and experience and in some cases, they were able
to re-tell che story in their own words. Music is an aural
art, requiring highly developed listening skills. For students
in the off-campus mode it would have been quite easy for
them to complete the semester of study having only
engaged in the sharing of vocal and oral work during
intensives. However by inviting them to complere a
response podcast, where they needed to script, speak/sing,
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Podcasting background

The term podcasting is a combination of ‘iPod" and
‘broadcast’ and describes a type of syndicated digital
audio that results in automatically downloadable
MP3 format files that can be played on portable
media devices, of whichiiPod is the best-known.
Podcasting has proven extremely popular with many
‘online citizens' creating their own regular online
audio shows. A true podcast alse includes
subscription; once the visitor has subscribed—often
a one-click process—new. podcasts will be
downloaded to their player or browser automatically
without having to return to the site and search. The
subscription service normally used is RSS (Really
Simple Syndication). When media files made
available through podcasting are posted to a site, the
publisher updates an accompanying RSS file with the
new media file's name, topic description, length and
location. Recipients subscribe to the publisher's RSS
feed only once, then each time they are online, their
weh browser or iTunes polls the RSS feed for new
entries and automatically downloads any new
content. There are an increasing number of
applications—such as GarageBand from Apple and
Open Source alternatives—for creating and editing
podcasts. Media companies, from traditional
broadcasters to newspapers, are experimenting with
podcasts distributed to a select but growing
audience.

One of the reasons why podcasts appeal to a new
generation of digital consumers and increasingly
mobile students, is their portability—podcasts can
be consumed en the go, using either a laptop
computer or portable media player, such as an iPod.
Podcasts are not confined to audio files, JPEG still
images, PDF documents and MPEG4 video can also
form part of enhanced podcasts. Podeasts containing
video are sometimes referred to as vodcasts or
videocasts, but the majority of podcasts are audio-
only or audio with images. There are fewer video-
capable players and audio podcasts are simpler to
make and easier to consume on portable players.
Having said this, the ability to hear aural content and
see its symbolic representation at the same time is a
favorable way of teaching any language—music
especially.

The integral hard disk can be usedto carry the
student's work, timetable, and school
correspondence and become a private portable part
of the student's virtual learning envirenment (VLE).
As podcasting becomes more popular in education
and moves beyond the realm of enthusiasts towards
established best practice, systems such as Apple's
Podeasting Server (iTunes U) are emerging which
enable teaching staff with near-zero technical skills
to automate the production of podcasts on an
institution-wide basis.
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arrange/re-arrange and produce the aural work, I was asking
them to embark on the creative process and therefore evaluate
and reflect on the use of their voice, sounds, and the telling of
the story, in and through the medium of sound. To be able to
make independent musical judgements, and function as
musicians in the context of an ECE setting, my students had to
be able to critically evaluate what they have heard, thereby
encouraging self-directed and autonomous listening.

Here are some suggestions for music educators wishing to
explore the use of podcasting in their own teaching:

* Keep podcasts short and to the point—15 minutes per week
is probably about right for most students.

* Use a system such as RSS to push the information out to
students—rthis is likely to result in a higher uptake than if
they students have to manually download the files.

* Be aggressive in overcoming technical problems at the starc—
for example, make sure files are easy to download both at
school and at home. T devoted classtime to explaining how to
make podcasts and how to download and listen to them.
Students received a mark for this ‘hurdle task’.

e Include motivating material such as interviews and topical
news articles in podcasts to keep them interesting and
relevant.

e Mainrain a live feel to the podecasts, and inject personality.

* Have all files you want to use in the right place and in the
correct format. I tended to make folders in my media browser
in GarageBand and carefully labelled them. I also marked
images and songs in iPhoto, iTunes and iPictures.

Based on this experience, podcasts seem to be an effective ‘net’
to help engage students, build a class ‘culture’, and disseminate
the important and fascinating problems that music as a
discipline addresses. Music is an aural art—and what better way
to be engaged and learn than in an aural way? N/

Fiona Phillips

A lecturer in music and music education in the School
of Education at Deakin University's Geelong Campus,
Fiona has developed expertise in music education and
technology with a particular focus on creative music
applications, podcasting, and developing virtual
collaborative environments for music learning in

Second Life.

E-CONTACT
Fiona Phillips: f.phillips@deakin.edu.au
Podcasting software: For the latest, check out
'Podcast’ on www.versiontracker.com

Université Lumiére Lyon 2: www.univ-lyon2.fr




/'Y BOTHER WITH AURAL TRAINING?

Whether a musician is classically-trained, a jazz performer, or a player in garage band, DEBORAH SMITH
says it's of paramount importance to be able to hear what you want to play in your head and the way you
want to play it, without resorting to your instrument first.

n every Australian state there is some requirement that our

| final year secondary school music students be able to aurally
perceive, comprehend and transcribe music using some form
of notation. This skill is one that makes for more highly-
skilled musicians (and audiences), yet it is an area for which
many students are under-prepared and, as a result, can find it
a terrifying experience.
Of course aural training should begin as early as possible
(preferably from kindergarten if noc earlier!) In the Australian
music education environment, however, this is becoming
increasingly unlikely. Therefore a common scenario
experienced by many teachers of senior secondary school
music students is that many students lack even the most basic

of aural skills.

So?

Over many years, students and colleagues have often asked:
‘why bother with aural training?’ It is usually these same
students and teachers who think that aural comprehension
skills are to be learned specifically for an end-of-year exam—a
separate study—one that is not really related to being a good
performer.

In response, [ ask these students and teachers to consider
what ‘aural comprehension’ really means—which is to

¢ : 0 3
comprehend music aurally’, or to fully understand the music
we are listening to or performing.

To be able to listen critically to your own and others’
performances, and to compare different performances or
interpretations of the same work, are some of the important
goals of aural training. Another worthwhile outcome of aural
training is to more thoroughly enjoy the experience of being
an audience member, through better understanding of what
vou are listening to. Being able to understand che function of
notes within a melody or harmony also provides vital
information for a performer.

For a classically-trained musician, being able to first hear the
difficult passage or sight reading exercise correctly in their
head, will ensure a more accurate performance once the
instrument is played. For a jazz musician, the abilicy to hear
what is going on and musically react to it is a basic
requirement of the style itself; and for a member of a ‘garage
band’ wishing to play covers, being able to correctly
reproduce what is heard is of paramount importance.

Often the term ‘musical literacy’ is linked with ‘aural
comprehension’. True music literacy is recognised among
many as the ability to *hear what you see and see what you
hear’. This can be explained as being able to see a written
score and to hear it performed in your mind, and to hear a
performance and imagine the written score. This ability is
invaluable for:

* developing inner hearing—sometimes referred to as
A s . I .
audiation'—that is, the ability to hear sound clearly in your

mind without the need to first resort to an instrument
* sight reading
* choosing music without having to play it first
* understanding relative pitch
» incernalising musical concepts
* developing secure musical memory
* developing improvisation techniques
* improving the ability to use music creatively—to compose
without the aid of an instrument.
How do I teach it?
In order to best find the answer to this question you need
first to briefly examine the nature of music. Music is sound,
and as such can be regarded as a language which can be

listened to, ‘spoken’ (sung and performed), written down,
read and used to create with.

In this way we are studying music as a language—one that we
learn to hear and understand, then speak, read and write, and
finally to improvise and compose.

Another thing to consider is that the learning of aural skills is
not simply about taking down dictation exercises (albeit
useful for assessment purposes). Rather it is about scudents
being given the tools and stracegies needed to be fully
functional with the language of music and to be fully
musically literate.

As we all know, there is no single ‘best method’ for teaching
aural skills; however it is universally accepred (if not
necessarily liked) that singing is the one essential pathway to
be able to fully express the language of music. Singing is the
most direct and personal way of reproducing musical sound.
The act of singing reinforces cthe sounds you are hearing in
your ‘inner ear’ in a way no other musical instrument can. It
is also a facc chat the ability to recognise and reproduce is
very firmly linked to the ability to ‘inner hear’ and sing.

Singing can take many forms. Students can simply hum or
sing the notes using letter names or numbers etc. It is in my
opinion—formed over the many years of teaching scudents of
all ages from babies to adults (including music teachers) that
moveable ‘do’/tonic/relative solfa (a funcrional/relational
system of note naming where the tonic of a major scale is
always ‘do’)* is the system that provides the maximum
amount of aural understanding and knowledge. Unlike letter
names and numbers, it is also a system that encourages
musical singing simply by the nature of the syllables used.

Suggested activities for teaching aural
comprehension

Rhythm

One of the most basic requirements for the understanding
and inner hearing of rhythm is very often overlooked—the
beat. If students do not have a solid understanding and

MUSIC in ACTION
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MODERN HARMONY
INTO THE CURRICULUM

Do extensions up to the 13th, altered notes, suspensions and secondary dominants have a place in
your curriculum? MICHAEL GRIFFIN argues that this type of understanding is exactly what students
will need when they want to arrange (or remix) in the popular/jazz style.

'have often wondered why there is not more focus on the

study of harmony in music education. Our curriculums
expect senior students to arrange or compose, implying that
in most cases, some knowledge of melody writing and
harmonisation is really needed. Yet these two staple
compositional tools are rarely developed in school music
classes. Some teachers of harmony go the route of traditional
four-part vocal style, but unless students are composing or
arranging for choirs, they seldom make use of these skills in
their Cl'f.'ﬂ{'ivf: \VD['](. PDPUlﬂI',"jﬂZZ—S[ylE {l'(ll'ﬂlony thel"l HPPCHIS
to students, but is sometimes treated as a less rigorous
alternative, being reduced to diatonic triads and perhaps an
extension® on the dominant.

Bur a unit of lessons on modern harmony that includes
extensions up to the 13th, altered notes, suspensions and
secondary dominants is less common. A pity, as this
knowledge is what many students require to arrange (or
remix) in the popular/jazz style. This harmony is as rigorous
(and perhaps even more so) than traditional vocal style, is
inherently musical, and fulfils the utility function for
arranging and composing. Not only does it provide a
satisfying end to a study of the rudiments of music theory,
but is another example of music education’s contribution to
divergent thinking tasks. That is, there is no single correct
solution, but there can be several satisfactory ones.

In this article I will provide some suggestions for the teaching
and learning of modern harmony. I like to provide clearly
defined parameters keeping students focused on present
learning content, and scaffolding for increasing complexity.
Therefore I start at the very beginning with primary triads.

Note that there are two aspects to harmonisation—chord
selection, and voicing. These can be raught side by side as the
concepts progress, or separately. The voicing will be typical
jazz piano voicing.

A suggested process for teaching modern
harmony

The three simple chords we call the primary triads together
contain every note of a major scale.

i ¢

D
—8 8
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Ensure students can

* Name and build the primary triads in any key.

in ACTION

armonise simple melodies using only primary triads.
* H ple melod g only p y triad
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* Identify non-chardal melody notes, such as passing and
auxiliary notes, which are left un-harmonised.

The secondary chords follow, so now students can build and
name triads on all seven degrees of a major scale. Practise this
in several keys.

Am Bm Em I
e § ks s
GO‘H —f= g = === == 1
o
Our simple melody can be harmonised
D Bin Ffm Em A (3]
= — = —:’_Z . :. — — rr = _7
“
-2 _ !‘ ! §_

When teaching seventh chords, students need to be quite
clear about the four different seventh chord types—major 7,
minor 7, dominant 7 and half diminished 7.

e Am’ Bm’ ca D7 Em’ ik
445 83 < 12 — —
! 2 3 e 5 6 7

Using these four-note chords requires good judgement, and is
largely determined by evaluating dissonant clashes. For
example, the use of a major 7th chord on a tonic note causes
dissonance. Other degrees of this chord do not.

ca o
0 t Q t e
0 —7r (==
o - T L3
oy 8 a-8
78 8 —————

Knowledge of the circle of fourths is essential for progressive
harmonisation. Students should be able to complete the
circle in keys as per the example below:

Seventh chord: CM7 FM7  Be Em7 Am? Dm7 G7 CM

Scale degree: 1 4 7 3 6 2 5 1



Understanding the way chords relate to each other and their
place in the 14736251 progression is a horizontal
consideration. We use this informarion, as well as the vertical
relacionship (melody within chord) to inform harmonic
choice. Most jazz melodies use at least a fragment of this
circle and very often finish with a 251 harmonic progression.
In fact, working backwards with the 14736251 progression in
mind is a useful harmonising technique. At this stage,
students should again re-harmonise given melodies, now
adjusting triads to as many 7th chords as possible.

Ffm' Em’ A7 b

=
; t: :f:;g =

The important ching to remember about extensions is that

they do not change the function of the chord but merely add
colour. So a G9 will satisfy the role of a G7, but sound richer.
As not all 7ths can be auromatically extended, examine which

co (el
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A secondary dominant is a dominant chord built on a
secondary tone within the key. Theoretically, this means
degrees 2, 3, 6 and 7 but in practice usually refers to the
minor tones 2, 3 and 6. Secondary dominants add life to
harmony, as the unexpected appearance of a dominant creares
a (usually) temporary modulation. Secondary dominants are
usually prepared and resolved within a 251 framework,

Chord Voicing

Mature chord voicing requires ar least four notes. As a triad
consists of three notes, we need to include one nore twice.
This is called doubling a note. In modern harmony, we
double the tonic note of each chord.

are safest, and when to extend. For example, minor 7ths can A Ctriad  4-note voicing possibilities

be extended to 9ths, but the chord built on the mediant A

requires an accidental: @v _g 8 §

(Ga9 Am? Bm? Can D? Em? [2e ~- -
= ﬂ Y (%3 n 7'- (&) oy
i 3 i ==
b5 gis 8 . . . . v 5 s
1 2 3 4 5 6 7 The tonic note of the C major triad, C, is used twice in this

At this level, it might be prudent to restrict extensions
beyond the 9th to the dominant 13th chord which is
particularly effective in the progression 2m®-513, This works
because the dominant 13th note is the same note as the 9th
of the 2m9 chord:

9th = 13th
Gm? Cl}
e g =
G——-8—3
) g

Alterations can occur in all chord families, but most
commonly with dominants . Like extensions, alterations do
not change the function of the chord, bur add colour. The
two most commonly altered notes are the 5th and the 9th.
The note to be altered is either raised or lowered a semitone.

Cbs

725

Suspensions are chords which include a non-chordal note
that usually resolves to a chordal note. The most common is
the 4-3 suspension. The example below shows a suspension
and resolution based on a triad, 7th and 9th chord.

Csus? C Clsust 7 Csus* c?

9 <>
——%

v o - = =S

As mentioned , if the melody note is the tonic of the major
chord, do not extend it to the 7th. Here, the M® and M8/
chords come into play. These chords do not contain a 7th
degree, so there is no semitone clash with the tonic melody

note. The chords have a ‘finished’ sound, useful in final

cadences.

four-note voicing. Notice that in pianoforte style it is typical
to have three or more notes in the treble and one or two in
the bass.

This voicing range is known as the middle to moderately low
register. It is recommended to stay within these notes:

[ & ]
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A 7th chord has four distinct notes and is usually voiced in
what is called the A form or B form. A form voices the
chord in numerical order: 1 3 5 7 from the bass note
upward. The bass—tenor interval will be either a 10th or 3rd.
Only use the 3rd if the bass note is high.

1 find it useful to refer to notes in their voice terms—soprano,
alto, tenor or bass.

B form is an inversion of A form. Ratherthan1 3 5 7 we
havel 7 3 5.

In the circle of 4ths, A and B forms alternate, creating
smooth voice leading. Notice the right intervals (3rd and
4ths) between alto and soprano.

ca P B Em’ Am’ Dm? a7 ca

¢

8 £35 £33
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Have the students practice this in several keys.

MUSIC in ACTION



9ths require a 5-note voicing. Extending the 2m?-518 progression with Mé/g:

Aform:1 357 9 A form
Ap - Dm? G C
o} 0
e 7
l”‘\'\ w5 e kD ©
A - S T e 8 = =
> 8 F—=8 8
Z oy =
B form is an inversion of the A form. B form
Ratherthan1 3 57 9 wehavel 7 9 3 5. " Dm? Gu C%
. a p- A
It helps to think in blocks, 3 5 and 7 9 stay together. Invert (s o o =
SO A" p={8] P=(8] QS
the two blocks to change voicing form. (2 = o =
Dm? Am? rax
y . s = o
Fl = £
D— a0 3 o -
[ 9 < )
9 . .
©7 The B form appears the more satisfactory in this key.
‘}: — (%] i
Z 1 . " » . .
o This turorial has been brief—certainly not as comprehensive

as your students will need. But with much practice and

several exercises, your students will be ready to take up the

challenge of harmonising 8-bar melodies like the one below.

Aform: 1 7 9 3 13 This is an example of a rich harmony on a simple melody. It
includes extensions, alterations, a suspension, secondary

B form: 1 313 gl dominants and smooth voice leading. If you would like to

The dominant 13th chord also has A and B form voicing.

Note the omission of the 5th in this voicing, hear how this sounds, you can download the MIDI file from
i - heep:/fwww.musiceducationworld.com
0 ] ! /ModernHarmony.html MwA
o 13 g
[ Fan iy [® ]
\.—3’ Ul b P 3 13 #‘ I
= po 3 Db Fin’ Ebmy? Ghae c* Fibo
a1 -
3
Z Ly 1

o1
©

The dominant 13th chord is particularly effective in the
. - . p y
progression 2m®-58. This is due to three common notes:

Dm? DFACE (13579)
G GFABE (179313)

B’ Gbaw Fmn’ Bem?
oy ——— = ===
A form B form :
2 ;‘L Lp : S !
Dm*” Gn Dm? G ! — Z — —
i N m {3 Z Z 6057
\3 F= %ﬁ:"e(: T T : ‘ f =
E =2 a7 e ————— m——— -
- e ) .
——a—=—— ([ —
7 . .4
The Major %9 chord is useful in completing a 2m9-513 Gbes Fal B AWsust  Abb Db
progression. Again, use a 'block’ mentality to gain a simple by, o —
understanding of the A and B forms. = — T i
# .h};‘ 5 sE ! ——
(b 27— = — =
Ge—a——7 5o
T ————1#
L 7 ) b i fJ ‘6‘ _.‘r.(..
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*The term ‘exrension’ refers to the addition of successive nates at
the interval of 3rd above the upper note of a triad—for example,

AURAL TRAINING Continued from page 21

the addition of a 7th, 9th, etc. In the case cited, the extension

would usually be limited to the addition of the 7th only.
Resources

Michael Griffin

Michael Griffin has been teaching music for over 20
years and has had a successful career as a choral
conductor and jazz ensemble director in Adelaide. He
was presented with the Education and Arts Ministers'
Award in 2006 and was nominated for a National
Teaching Excellence award in 2005. Michael is Head of
Music at Dubai British School. He has recently
published the books Music and Keyboard in the
Classroom series, and Modern Harmony Method. As a
pianist, Michael has performed throughout Australia
and continues on a regular basis in Dubai.

Examples are taken from Musicianship and Aural
Training for the Secondary School, Level Two and
Music Solo Performance, by Deborah Smith:
www.dsmusic.com.au

Kodaly Music Education Institute of Australia:
www.kodaly.org.au

Note

* For the origins of moveable ‘do’ solmisation, see
Robin Stevens, 'A system ahead of its time’,
Music in Action, Winter 2008, Vol. 6, Issue 1.

E-CONTACT

E-CONTACT

Deborah Smith: <deborahsmith@aapt.net.au>

1} Referem:es by Mlchaal Grlfﬂn may be found
( at: w .musmeducatlenwmid.cem

JUPITER.

The best dollar-for-dollar instruments available ...
from the world's fastest growing band instrument company!

Flutes | Clarinets | Piccolos | Saxophones
Trumpets | Cornets | Flugelhorns | Trombones | French Horns
Tenor Horns | Baritone Horns | Euphoniums | Tubas | Mellophones | Sousaphones

World Class Quality
AR I=1+0=

Jupiter instruments or component sections are assembled
in any of five Jupiter factories worldwide and each
contains parts produced in Taiwan, Japan, UK, Italy,

Germany, France, Switzerland, Canada and the US. www.jupiterinstrument.com
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- STAGE’IN CLASS

In an article in the previous issue, ‘Developing Centre Stage: Creating a local version of Musical
Futures', we read how the principles of UK-based Musical Futures are used to develop a Year 7 and 8
classroom music curriculum that responds to the requirements of the Victorian curriculum.

HENRY VYHNAL now concludes by describing suitable classroom delivery strategies.

Working within the Victorian Essential Learning
Standards (VELS)

VELS is the basis for curriculum and assessment in Victorian

schools. Tt has three Strands—

1) Physical, Personal and Social Learning

2) Discipline-based Learning

3) Interdisciplinary Learning.

The Arts is one of six Discipline-based Learning Domains.

Each of the Domains is divided into Dimensions—in the

case of The Arts, these are ‘Creating and Making’, and

‘Exploring and Responding.

However, in the spirit of VELS, I don’t limit myself to The

Arts in teaching the Centre Stage unit, but also respond to

e the ‘Listening, Viewing, Responding’ and ‘Presenting’
Dimensions of the Communication Domain (within the
Interdisciplinary Learning Strand)

¢ the ‘Building Social Relationships” and “Working in Teams’

Dimensions in the Interpersonal Development Domain
(within the Physical, Personal and Social Learning Strand).

[ use the Standards within these Dimensions because I believe
that, in addition to the discipline-based Dimensions usually
associated with music learning, the knowledge and skills
associated with communication, and the interpersonal
development associated with the rehearsal and performance
process, are equally important. (See box, p.27)

Outcomes

For me, these standards describe a music development process
rich in teaching, learning, presenting and assessment
opportunities. By music development process, I mean music
selection, rehearsal, arrangement, interpretation, reflection
and communication. This process is no different to the
activities of any competent group of musicians anywhere.
The only difference is that in the classroom the musicians are
young and inexperienced. The ultimate goal—thac is,
exemplary performance—is the same.

Process

Because I use Music Futures principles, my students will:

e generally use the Internet to select their music. From there
they download lyrics, MIDI files, guitar, bass and drum
tablature and free sheet music. Because my school blocks
the downloading of audio files, students cannot access them
using the school’s network. However they can use their
home Internet accounts, and swap audio files with each
other (often using the school computers as a music file
storage system).

usually learn the music piece by ear (using headphones with
iPods or other MP3 players) from each other and by
tablature, Sometimes they learn from sheet music—if a
member of their group has sufficient music reading and
teaching skills.

ACTION

e play music that they’re interested in (rather than a set of
pre-determined works). Only if they are unable to decide
on what to play are they provided with musical materials
(sheet music, tablature, MIDI files) to play.

come together in ensembles according to what they can
contribute. Some students play in several ensembles and
have different roles (instrumental or vocal activities) in each
ensemble, whereas less musically-capable students often
assume music recording or sound production roles that
support their performances.

learn technique through playing a piece itself, rather than as
a separate discipline. Their teachers are often their peers or
online music tuition websites. T fill in the gaps' when I am

able.

Ideally, class resources should include a series of fully-
equipped rehearsal rooms, each including recording and
music editing facilities and broadband Internet access.
Unfortunately this is not the case for my school, nor for the
majority of music teachers in the government school system.
In order to create an environment that allows simultaneous
multiple projects to move through a music selection, rehearsal
and presentation process, | use several strategies:

« The classes (usually a double session of approximately 90
minutes) are segmented into 15-20 minute sub-sessions.
Facilities and instruments are ‘changed over’ each sub-
session (if appropriate). This ensures that the facilities are
shared equitably and that students focus their activities on
the achievement of goals that are possible in that time
frame.

Every available space is used. In the warmer months, some
students rehearse outside and use verandas and other
playground areas in addition to the classroom. The
classroom itself can support up to five small acoustic
rehearsals. The school organiser has learnt the wisdom of
not booking adjacent classrooms to mine (if possible)
during these sessions. This means that during the colder
months [ am able to expand my activities into those nearby
vacant rooms so that additional small groups and individual
students who play loud acoustic instruments, such as
saxophone, can use them.,

Acoustic instruments are used wherever possible. Amplified
inscruments (if required) and public address systems for
singers are only used in the preparation of the final
presentation.

Drum kits can only be played at very low volume once the
music rehearsal process has begun.,

Extensive use of MIDI files ensures that backing tracks in
the right key for singers can be created. In addition,
students are taught to use the ‘vocal eliminator’ setting on
our mixer to create backing tracks from original recordings.



Maintaining project process and focus is
essential in this teaching and learning
method, otherwise the classes can
descend into a ‘stodgy’ amble that has no
momentum or purpose. To guard
against this I ensure that there is a
rigorous ‘show-and-tell” activity at the
beginning and end of each double
session. Students are required to
maintain a diary that describes each
session. The essencials of each diary
entry are:

e what the students achieved

* how well or poorly they worked (and
the reasons why)

* what the students are required to do or
procure before the next session

* what their goals are for the next session.

Additionally, students develop a project
plan that sets out their progress for each
week of the development process leading
up to the final performance. During the
project, this plan is consulted to
determine if strategies need to change in
order to deliver the presentation on the
agreed date.

Moving towards performance
presentation

The Centre Stage VELS unit lases 10
weeks. The process comprises two weeks
for introduction, music selection and
procurement, four weeks for
development and rehearsal, and four
weeks for performance development and
presentation. Reminding students of this
progression is a powerful motivator.
Performance is all about delivering the
best presentation possible on a specific
date. The best presentation only occurs if
all risks have been identified and
addressed.

In the final four weeks, [ create several
presentation opportunities that
strengthen the final presentation. These
opportunities take the following formars:

* A private presentation to me, where
[ ascertain what still needs to be done
to begin the final countdown. This is
usually an informal acoustic
performance from which I decide
whether they are ready for the work-in-
progress presentation.

* A presentation to the class that can be
considered a work-in-progress. The
performance must be a coherent ‘stare-
to-finish’ one, using all the production
facilities planned for the final
presentation.

* A recording of the performance (usually
audio bur sometimes video)
accompanied by an intense deep
listening evaluation by the presenters as

well as the class audience.

* The penultimate performance under
final performance conditions. This is
assessed and marked. T explain how it
could be furcher improved and the
ensemble is given the choice to present
again to improve their mark by
incorporating my final suggested
changes.

Record keeping

I usually teach four classes of Year 7 and
8 music each semester. With up to 25
students in each class, it is ditficult to
stay in touch with each studenc’s
contribution to every presentation. At
report writing time, the ability to have a
useful amount of relevanc data for each
student is crucial. I use a self-designed
Excel spreadsheet to record studencs’
progress through each stage of the unir.
For each student, the dara [ record
includes the title of the music piece, the
ensemble(s) they belong to, their project
role, the progress of the ensemble, items
or tasks I need to do in order to assist the
ensemble, comments on all pre-
presentation performances and the
assessment marks (performance
assessment and diary). The spreadsheet is
updated as often as new dara is measured.

The benefits

In my experience, most students prefer
the playing and performance of music to
the ‘book work’ associated with learning
about music notation and musical
culture and styles. The model I use for
‘Centre Stage’ places the standard
rehearsal and performance process at the
centre of music classroom activity.

Music teachers should all be familiar with
this process but, for whatever reason,
many are unwilling or unsure about how
to ‘unlock’ the plethora of music learning
activities implicit in the process and
make them ‘Centre Stage’ in their junior
classroom music teaching. Many confine

this way of teaching to stage or concert
band rehearsals.

[ encourage music teachers to be
musicians with cheir scudents, and share
their love of music making in a practical
way that acknowledges problem solving,
conflict resolution and team building, as
essential elements of music making,. Min A

E-CONTACTS

Henry Vyhnal:
<hvyhnal@netcon.net.au>

Musical Futures:
www.musicalfutures.org.uk

VELS: http://vels.vcaa.vic.edu.au/
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B New Products

RELEASES

FROM HAL LEONARD AUSTRALIA
http://halleonard.com.au/

ChoralTime! for Primary Schools
Book 2 for Years 1 & 2, Years 3 & 4,
and Years 5 & 6—George Torbay
Books and CDs.

The Book 2 series of ChoralTime! is a
wonderful collection of grear songs for
your primary school choir or
classroom. The repertoire features
pieces suitable for festivals,
graduations, concerts or singing just
for the enjoyment of it! The
compiler/editor, George Torbay, is one of the most sought-
after choral conductors in Australia. Each exciting pack
contains: 5 songs arranged specifically for young voices; full
choral scores; vocal scores with reproducible pages; valuable
performance notes; ideas for effective choral warm-ups; and
an audio CD including full performance tracks, individual
vocal tracks for each part and piano accompaniment track
suitable for rehearsal and/or performance.

FROM AMPD (ALL MUSIC PUBLISHING & DISTRIBUTION)

www.ampd.com.au

SCHOTT:

Three Ragtimes by Scott Joplin—arr. Wolfgang Birtel
This small selection of Joplin rags is of course not complete
without “The Entertainer’. In comparison, ‘Easy Winners
and ‘Rag-Time Dance’ are no less fun to play, particularly
since in the lacter the performer not only has to play but also
stomp his foot. Excellent music providing entertainment for
many occasions! Available for Violin, Viola, Cello Flute,
Clarinet, Alto Saxophone and Bassoon.

HERITAGE MUSIC PRESS:

. Music Treasure Hunters
| Board Game—Brenda
Knowis
Learning is serious stuff, but
it can also be great fun! This
game was created to provide
| children with an exciting
and interactive learning
experience and is ideal for 2
to 8 players or teams. The
100 question/answer cards
‘ contain questions in three
different categories, (music terms, instruments, and
composers) and the cards come in two different levels adding
flexibility. All game pieces are included—you just add the

laughs!

ACTION

MceGRAW HILL:

Opera and Music Theatre
Resource—Geoff Lowe & Su-Lyn
Chong

MUSIC THEATRE RESOURCE
This book offers extensive coverage of
the Opera and Music Theatre

Oyera i ,
-4 medlun'ls 1n rwo separate sectrions.

This unique resource for Years 7 to 12
examines the origin of style varieties
from both historical and musical
angles, offering teachers plenty of
fexibility to design their own material.

FROM ENCORE MUSIC DISTRIBUTORS

WWW. cncoremusic.com. au
KJOS:

Theory Gymnastics by Three Cranky Women

This is the most creative and comprehensive theory available
and the perfect companion to every method. By combining
hilariously funny games with these creative boaks, music
theory has been elevated from boring to fun.

Level A: Brillante (ages 4-7) and Level A: Animato (ages
8-11) are the starting books based on the students’ age that
include the music alphabet, the grand stafl, steps and skips on
the keyboard and staff, rhythm up to eighth-note pairs and
maore.

Level B: Spirito includes concepts such as notes on the grand
staff, intervals on the staff and keyboard rhythm up to dotced
crotchet, half steps,whole steps and more. Spirito roughly
correlates with levels 2 to 3 of most popular piano methods.
Level C: Con Moto includes concepts such as the
introduction of meter, order of sharps and flats, rhythmic
dictation, composition and more.

TWOFOLD MEDIA:

Violin Alive Volume 2—Fintan
Murphy

Books and DVD.

This material has been re-
mastered into a DVD-ROM and
expanded to include more scales
and arpeggios, more on bowing,
more on vibrato and new scores
of the practice points. There are
four volumes in the series
covering exercises, scales and
arpeggios as well as key
techniques, bowing, left hand
and resources.



Kool Piano Series—Glen Carter-Varney

Books and CDs.

This series includes Kool Jazzy Tunes, Kool Shades of Blue,
and Kool Piano. Each in the series contains a CD enclosed
with a full piano recording as well as a background
accompaniment if desired. The pieces are an introduction to
several contemporary styles such as rock, swing, dixieland,
blues, Latin etc. They are bright and catchy and may be
played purely as a piano solo or with the backings.

FROM ALFRED PUBLISHING

www.alfred.com

A World of Happiness—Tor
Hyams & David Scharff, with
Denise Hyams

Book and audio CD.

. A World of Happiness is a
delightful book and CD
collection of rich and diverse
musical entertainment for young
children and grown-ups alike.
Led through this special world by
engaging characters such as
‘Knowa' the cat and ‘Lady Leo-
Lani’ the ladybug, children will
discover A World of Happiness
through the inspiring stories and toe-tapping, thoughtful
songs. With the lyrics and sheet music for each song on the
CD included, each age-appropriate chapter focuses on a
positive, universal character trait and conrtains a relared
‘Happiness Activity’ for children and grown-ups to explore
together. For teachers, there are accompanying music lesson

plans.

Movin' in the Right
Direction! (A Program or
Songbook to Build
Character and Integrity in
Young People for Unison
and 2-Part Voices)—Sally
K. Albrecht & Jay
Althouse, orch. Tim
Hayden

Movin' in the Right
Direction! is a vibrant and
contemporary 20-minute
performance presentation
designed to help build
character and integrity in
young singers. Teachers,
students, and parents will enjoy the lessons that can be
learned through this presentation. The texts reinforce positive
concepts and goals. The seven songs, set in a wide variety of
musical styles, may be sung separately or put together with
the connecting narrations (35 spoken lines in all).

MOV'N NTHE |
RIGHTD R,ECTONT

Iegrity in Yeumg Propie fof Unizon and 2-Part Yoices
by Salty K. Albrech and Jay Althouse

oSy,
o

B New Products

Music Fun 101 (101 Reproducible
Music Games and Puzzles)—Sue
Albrecht Johnson

This incredible publication includes
all your favourite games and puzzles,
from Alphagrams, Matching Puzzles,
and Crosswords to Name That Tune,
1 Musical Sudokus, Word Searches,

| Mazes, and more! Clever, educational,
| reproducible, and fantastic fun for

e everyone, Music Fun 101 is a valuable
resource for your music classroom.

“Slc
101%’

5.2 g Manic Lamet and

Sut Albrecht Jahmion

FROM ROLAND CORPORATION AUSTRALIA

www.rolandcorp.com.au

INTELLIWARE:

Band-in-a-Box PRO 2009
Every school should have Band-
in-a-Box, now with 40 new

| features including: Real Charts—
notation and on-screen guitar
display for many of the
RealTracks, allowing you to hear
the audio performances, and
see/learn from the on-screen
notation, tab, and on-screen
guitar fret board; Enhanced
Audio Chord Wizard that figures
out chords from MP3 files;
Enhanced RealTracks, with
improved arrangements and sounds; a new Freeze Song
option that allows you to freeze and save a song arrangement
so that it plays back quickly without requiring regeneration of
RealTracks and other tracks; and The MIDI Wizard is
improved, with a Melody Wizard that allows you to trigger
notes from the Melody, including approach notes.

I
™

RealBand Pro 2009

RealBand is a fully-featured and
powerful music arranging, sequencing,
and digital recording program.
RealBand is a new program that
combines the most popular features
from PG Music’s PowerTracks Pro

=8 Audio and Band-in-a-Box programs
into an all-in-one sequencing program
with automatic accompaniment. With
RealBand you can create an
arrangement with Band-in-a-Box
tracks; type in the chords, add RealTracks and
RealDrums that follow the chord changes, add your own
tracks, and then edit and produce the finished song without
ever leaving the program!

ACTION



B New Products

FROM SHRIRO AUSTRALIA

http://www.shriro.com.au/

Casio CTK4000 Digital Keyboard

The Casio CTK4000 has brought a whole range of
possibilities to the world of 61-note portable keyboards.
Plug in your iPod and use your keyboards high quality
speaker system, play along to your favourite track, or even
sample a sound and use it in your own arrangement. The
new ‘Step up lesson system’ enables you to listen to the song
you want to learn, then watch the large LCD screen as the
keyboard shows you the notes, keys and which fingers to
use. With Casio’s ‘Plug and Play” technology you can
connect to your PC/MAC and instantly use your favourite
software to create your own masterpiece. This feature-
packed keyboard comes loaded with Tones (570), Rhythms
(180) and Songs (152) plus 5 song/6 track recorder.

FROM DYNAMIC MUSIC

www.dynamicmusic.com.au

ZOOM Hé4n Handy Recorder

' This audio recorder features a
sturdy, rubberised chassis,
switchable 90 degree to 120
degree condenser mics, large
LCD screen and even easier
use. The H4n is the only
handheld recorder that allows
recording on four channels
simultaneously by using
your own external mics
with its onboard mics. It
can also be set to

continuously record the
most recent two seconds
of audio in memory so that
you'll never miss the beginning
of anything you want to record, even when it begins
suddenly. The H4n is now a USB 2.0 Hi-Speed device,
meaning that files can be transferred to a computer at the
highest rate available. Then use the Cubase LE4 recording
software supplied for editing, create your own original CDs,
post your recordings on your MySpace page or send out
your recordings by email ... the possibilities are endless.

1 _ﬁiﬂﬂmﬂiz‘

A holistic approach to music education integrating singing,
speech, movement, dance and playing instruments.

WWWwW.ancos.org.au

Follow the links to your state for membership, courses, conferences and workshops.
Events focus on “learning by doing’ helping teachers share their music through practical music making and by creating
enjoyable experiences for the students.

3-8 January 2010 The Victorian Orff Schulwerk Association

- Immanuel College, Adelaide
National Orff Schulwerk Conference in 2010 with local
and international presenters featuring Lenka Pospisilova
(Prague), Reinhold Wirsching (Austria), Sarah Reeve
(Australia) & Lynn Kleiner (USA), 5 days of accredited
professional development in music & movement
education, and over 40“hands on” workshops.

ACTION

WWW.vVosa.org &

for VOSA Sales, Resources and Events  RigSF

« Living Music & Dance 29-30 May 2009 in Preston

- Joy of Jammin’Stage 2 Melbourne 29 June - 3 July 2009
in Hampton

« Marimba Family Camp 17-19 July 2009 in Healesville

» 13" Early Childhood Conference of Performing Arts
(ECCPA) 22-23 August 2009 in Kew
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THE MOST OF OUR LIBRARIES

How to find, explore, search and gain access to music resources, repertoire and knowledge.
ROBYN HOLMES, Curator of Music at the National Library of Australia, gives some practical advice
about using our national, state, public and school libraries most effectively.

1. Get to know your library and your librarian
Your business is the teaching and learning of music. A
librarian’s business is to help you find, explore, search and
gain access to music resources, repertoire and knowledge.
How much support do you get from your library? How
much do you ask for help? Have you identified a library that
can help you specifically with music?

A library of music is fundamental and essential to almost
every aspect of music making, teaching and learning. You
might have spent a lifetime—and probably a fortune—
building your own personal library of music resources, or
alternatively depend on what is readily available at your
school, your community or from your colleagues. But to
what extent do you strategically use your local library to
broaden and extend your materials and expertise? Are you a
member of your state library? Have you considered
membership of the National Library? How can you get help?
Who can best help you with music?

In general, libraries in Australia have a long history of
cooperation. The National Library of Australia, the state and
territory libraries, your university, public and education
libraries are largely networked and their organisation parallels
the three levels of government. More than 1,000 Australian
libraries, including specialist music libraries, aim to work
together to collect resources and, where possible, to make
these available to you, wherever you live or work.

2. Join your National Library and state libraries as
a 'reader’ or ‘member’.

Most of you would have had access to a specialist music
library at your place of study. But what happens next, when
you are out on your own in a school or private teaching
studio? For a start, become a reader/member of both your
National and your own state library. For the National Library
it doesn’t matter where you live or work—you can register
online right now, free of charge, and it’s open to all
Australians. Your state or territory library specifically directs
its services towards people resident in that region.

The National Library holds over 9 million items including
books, journals, maps, pictures, manuscripts and oral
histories. But did you know that the National Library also
has the largest research collection of music, music
informarion and services in Australia? Best of all, you can
access these music resources—you just need to know how!
Additionally, there are journals, indexes, databases, archived
websites and guides in electronic form (e-resources). If you
are a registered reader, many of these are available to you, free
of charge. For example, Grove Music and all the other
Osxford Music Reference databases are available online to you

ACTION

at home, under the terms of the subscription paid for by the
National Library.

How do you register? Go to the home page of the National
Library of Australia (www.nla.gov.au); click on ‘Get a Library
Card’ and follow the instructions. You will be sent a reader’s
ticket with a unique number that enables you to log into the
e-resources or request material from the Library’s online
catalogue. If you physically can’t visit the Library to use
material or databases, you can order copies of items through
the ‘Copies Direct’ service directly from the online catalogue.
If the Library cannot copy an item for copyright reasons, you
may be able to still borrow it, by asking your local librarian
to request it from the National Library (note that the
National Library cannot lend directly to individuals).

The State and Territory libraries in general mirror these
National Library services. Each has a process online for its
state or territory residents to ‘register’ as a reader, akin to the
Narional Library. Each of the state libraries holds specialist
music resources, and some states like Queensland and
Western Australia support musical activity by distributing
and managing scotes for performance throughout the state.
For a small fee, you can also become a member of the
Australian Music Centre (www.amcoz.com.au) in Sydney
which will assist in reproducing Australian scores and parts
for performance and provide related resources. All these
libraries work very closely too with the specialist music or
performing arts libraries in the higher education sector.

3. Your library is a resource—your best gateway
to the online world

Libraries today are much more than repositories for books
and scores. New technologies mean libraries are now also
gateways to the online world, and librarians are the finders of
knowledge in the electronic space as well as in the stacks.

Why bother to use your library online when you can just
Google? Libraries have always been trusted repositories of
knowledge. Similarly, reference librarians are ‘maestros’ at
sifting, sorting and organising the maze of information that
search engines like Google just help you discover. Better
searches {(and searchers) equal betcer results! Librarians at
research libraries can help teach you how to improve your
research and searching skills. They are expert at connecting
you directly to the best resource for your needs, showing how
you can get the content online or else finding where to access
it. There are also networks of music librarians and sound
recording archivists in Australia, who are expert in their field.

THREE SERVICES TO HELP YOU

(i) ‘Ask Now’ is a ‘Chat to a librarian online’ service



(www.asknow.gov.au) available any time between 9 am and 7
pm, Mondays to Fridays. This is a virtual reference service
staffed by librarians in Australia and New Zealand. It aims to
provide high quality informarion to people about any topic,
with the convenience of immediate, online communication
in real time. However, this is a quick, ready-reference service,
and for more complex questions, you may be directed to
specialists or ‘Ask a Librarian” online inquiry services at the
national and state libraries.

(ii) ‘Ask a Librarian’ is a service available from the home
page at the National Library (www.nla.gov.au) or by phone
on (02) 6262 1266. Staff can respond to enquiries on a
broad range of topics, including music and dance, provide
specialist advice and information abourt using the Library's
collection, support you in your research efforts or offer
alternative research avenues and sources of information. The
National Library has specialist music and dance staff, as well
as a Music Cataloguing and Acquisitions unit and a Music
Australia manager, so that the NLA is well-placed to assist
you with your music inquiries. Each of the State and
Territory libraries offers a similar ‘ask a librarian’ reference
service, and can provide specific support for access to their
own collections.

(iii) ‘Libraries Australia’ (www.librariesaustralia.nla.gov.au)
is the service that networks all Australian libraries. Its simple
search interface provides a gateway to all resources held in
Australian library collections. The search resules tell you what
the item is, where the item is held and how to contact the
organisation, how to order a copy, and even at which
bookshop you may be able to buy a copy online. You can
limit your search just to music if you want. Your local
librarian may also be able to access the full subscription
service, which enables you, in just one single search, ro also
search Australian journal articles and research repositories,
the British Library, Library of Congress, and WorldCat (the
World Caralogue) amongst others. No piece of music can
escape being found-—that is, assuming it is catalogued online
(and to be cautionary, not all are!).

4. What about making Australian music your
focus?

Ever thought of orienting your music curriculum towards
Australia? There is something especially exciting about
studying, creating or making music in a living and real
context in your own backyard!

In addition to capturing contemporary musical creativity,
Australian libraries are constantly digitising our documentary
heritage—to make the vast collection of books, manuscripts,
photographs, ephemera, music and so on more accessible to
more Australians. Mostly, this is free to you at your desktop.
For example, you can explore the Digital Music Collections
of the National Library (www.nla.gov.au/digicoll
/music.html), as well the Library’s new online audio delivery
of oral histories of musicians and folklore in Australia
(www.nla.gov.au/digicoll/audio.html). Similarly, some state
libraries showcase their own state’s musical heritage—for
example in Music Queensland (www.slq.qld.gov.au/coll
/musd/musq), South Australian Memory

(www.samemory.sa.gov.au/site/page.cfm?u=751) or Western
Australian Musical Memories (www.slwa.wa.gov.au/wammo
/index.html). Mostly, this music is digitised printed music in
the public domain and can be accessed free of charge: you
can download it, print it, reproduce it or order higher
resolution copies for inclusion in curriculum macerials.
Some of the heritage sound recordings of the National Film
and Sound Archive (www.nfsa.gov.au) are also available
through Music Australia (www.musicaustralia.org/).

Libraries Australia provides access to all music, whether it’s
Australian or not. But if you want to focus on Australian
music, music information and musical life, then Music
Australia (www.musicaustralia.org) is the best way to find
this quickly and easily! It showcases Australia’s musical
culture across contemporary and historical periods, from the
earliest published music to the latest hit, including all types,
styles and genres of music. Its focus is Australian—wherher
created, performed or published in Australia or by
Australians, or associated with Australia’s musical culture.
From a single search, you can find resources across all
formats including printed music, sound recordings, multi-
media, archives, websites, and pictures, as well as informarion
on more than 5,000 Australian musicians and organisations.
You can find in Music Australia nearly 700 educational kits
and links to some online interactive music materials and
archived websites. Where music is online, the service will
take you directly to the digital content. Where nor, the
service functions like Libraries Australia—it will give you
information abour the item, and show you in which
collections it is held. The Australian Music Centre
(www.amcoz.com.au) is just one agency that provides all its
records to Music Australia. The Centre has a specific
commitment to creating resources for music teachers and will
soon be making many of its materials accessible online.

5. Integrate music into other areas of the
curriculum

Do you work with your colleagues in other curriculum areas?
Music is a great lens through which ro view Australian
history, culture and the changing face of the nation, its
people, its events, society, its celebrations, icons and myths.
Music Australia (www.musicaustralia.org) includes a number
of themes around which seaff have curated significant
topics—for example, Australians at war, the bush and the
beach, Australian places, sport, aviation, railways, children,
music of many lands, topical songs —or grouped around
music of specific interest, such as folk music, ARIA winners,
anthems, Indigenous music. The Learning Federation has
written notes for teachers around at least 200 of these items.
A single search in Picture Australia
(www.pictureaustralia.org) gives access to 1.4 million
digitised photographs, arcworks and artefacrs that illustrace
Australia, which are held in various cultural organisations.
The service also enables individuals to contribure Flickr
images around particular projects (www.flickr.com).
Historic Australian Newspapers 1803-1954
(htep://ndpbeta.nla.gov.au/ndp/del/home) is the newest
national service released by the National Library and gives
people the capacity to comment, add, correct, and tag
newspaper articles as they appear online. You might be

MUSIC in ACTION
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SASHA PLAYS PIANO BEGINNER TO INTERMEDIATE 1
SONNY CHUA ARRANGEMENTS

Designed as additional
repertoire for students
learning piano

Plays Piano
Play )
Beginner to Inlermediate Piano

* Piano Solo arrangements
of well-known songs

*  Progressively graded
* Lyrics included

* Contains technical
challenges to enhance
general leaming

Sonny's proficient and cheeky style shines through in
these arrangements which provide an educational
setting for repertoire teachers and students will love.

Song list:

| Am A Rock High Hopes
Steer My Happiness
Bananas In Pyjamas Oom Pah Pah

| Got You Riding In My Car

Going Te The Zoo Shape I'm In
Music! Music! Music!

Red Rubber Ball

Wimoweh

Ducks Don't Need Satellites

He Ain't Heavy He's My Brother

MANHASSET"

.{%@m)@ﬂy 'gamy'mm{y
%ﬂdé&mw, Wt

SIMPLY THE BEST MUSIC STANDS

Manhasset Music Stands are the best-designed and
longest-lasting music stands available. Perfect for
School or institutional use, they:

*  have no knobs or removable parts to lose or break
*  have the best height to weight ratic in the indusiry

« have a very stable base, yet small footprint
for crowded stage and storage

«  are lightwelght yet amazingly durcble
«  are of the highest quality

¢ come with a
5 Yeadr Warranty*

* The Manhasset Specialty
Cormpany warranties all of

its products unconditionally
against defects in materials
and workmanship for o pericd
of five years from the original
date of purchase.

For your nearest stockist and a free catalogue call
1300 345 513 or email manhasset@ampd.com.auv

BY NOW YOU SHOULD HAVE RECEIVED YOUR
AMPD 2009 EDUCATION CATALOGUE. FOR
ADDITIONAL COPIES CALL 1300 365 513.

Distributed by

AM—d

ALL MUS|C PUBLISHING & DISTRIBUTION PTY LTD
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surprised about how much musical news can be found in
them!

6. Create your own resources and share them
Various professionals across Australia are working towards
enabling individuals to upload their own music education
materials into a shared Australian space: at a richer, deeper
level than YouTube and MySpace Music! The Music Council
of Australia (www.mca.org.au/) is also actively supporting a
range of think-tanks abour the digital environment to assist
the Australian music industry and music organisations.

In the meantime, publishing of music materials continues
apace, in printed form, audio-visual or mixed media, or
directly online. There is national Legal Deposit legislation for
music. If you are creating and publishing materials in any
written form, even under your own publishing name, then
you are legally required to deposit a copy in the National
Library for permanent preservation; the Library tries to
purchase a second copy for lending. The National Library
also runs the International Standard Music Number agency
(www.nla.gov.au/ismn/about.huml) chat provides you with a
permanent identifier for your music publication, just like
ISBNs for books.

Legal deposit does not yet extend to electronic, web or audio-
visual publications—but responsible creators will deposit
copies in relevant institutions so that together we can create
and sustain a permanent record. These can then be shared
and made available, Libraries and archives recommend you
adopt certain standards for publication, especially in
electronic formats where digital preservation becomes a
complex nightmare that national libraries and archives around
the world are working together to solve. Put simply, shared
and agreed standards help us all share our knowledge and
collaborate more easily in this digital age. The National and
State Libraries all write and publish guidelines related to a
myriad of issues, from metadata to writing for the web. So, to
the theme of all these tips—just ask!

One final word on copyright. Libraries and archives respect
creators’ and publishers’ rights. Sometimes though, they are
the only organisation to hold material that is not
commercially easy to obtain. Licences that cover reproduction
and use of music in educational settings aim to manage the
balance between rights and access: so, if a creator, register
with APRA (www.apra-amcos.com.au), and if a consumer,
always check your licence before copying. A

E-CONTACT
Robyn Holmes: <rholmes@nla.gov.au>
Curator of Music, National Library of Australia
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CLASSROOM RESOURCES

Music notation programs such as Encore, the Finale range, MusicMaster, Noteworthy Composer,
Quick Score and Sibelius can create not only scores for ensembles, but also your own custom-made
classroom resources. KATIE WARDROBE looks at a few of the options, using Finale and Sibelius as

examples.

Would you like to create your own custom-made classroom
resources? Whether you're using a full-blown notation
program, or just the resources at hand on the Internet, there
are options available for everyone.

1.Blank manuscript paper

One of the classroom resources most frequently used by
teachers is blank manuscript paper. Sure, you can go to your
local music store and purchase printed notepads or books,
but did you know that you can create your own, at little cost,
custom-made exactly for the job at hand? You may require
large staves for your primary students, or a specific group of
instrumental staves for your Year 10 scudents’ composition
assignment, or even a set of staves with pre-printed clefs and
key signatures. All are possible.

You can do all of this in notation programs such as Sibelius or
Finale, but there are also some effective free online resources
which handle the job with ease. One such online resource is
at www.blanksheetmusic.net. Head to the website and start
by wartching the Quick Turtorial video. It shows you how to
add clefs, change the size of the staves (‘scale’) and the
orientation of the manuscript page. More advanced options
include creating groups of staves, adding key signatures and
time signatures, changing margins and altering the shade of
your stave lines. Once you've set up your blank manuscript,
you can save the formac as a template for future use. There
are also some ready-made templates in the Scaff Paper
Directory.

2.Flashcards

Creating your own custom-made rhythmic or melodic
flashcards in notation programs will give you the most
Hexibility with formartting, musical fonts and symbols. You
can print your short melody or rhythm directly from the
program to create your flashcards, or alternatively you can
copy the melody or rhythm into Microsoft Word as a
graphic. Copying your melody or rhythm into Word allows
you to easily control the size of the resulting graphic and the
page orientation of your flashcards. You can also put a few
melodies or rhythms one after the other in the same Word
document, print the page and then cut the rhythms/melodies
into strips ready for laminating. Here’s how:

Create your score

As an example, we'll create a two-bar melody which we'll turn
into a melodic fAashcard—so to gert started, open Sibelius or
Finale. Set up a treble staff with a 2/4 time signature and
create the melody below.

0 |

il

) I

To make our flashcard look neat and tidy, we'll isolate those
two bars before copying and pasting into Microsoft Word.

In Sibelius, select the barline at the end of the two-bar
melody and press ‘Enter’ (Windows) or ‘Return’ (Mac) to
insert a system break. The two bars will stretch right across
the top of the page, so we'll re-size them by selecting an
invisible ‘handle’ that’s located just beyond the end of the
stave. Click just to the right of the stave until a small purple
box (‘handle’) appears. You then drag that box to the left, to
adjust the length of the two bars.

f) | |
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In Finale, click once inside bar three (it will turn blue) and
key the down arrow once to send the remaining bars in that
system down a line. Next, select the Page Layout tool.
‘Handles’ will appear around the ‘system’, and you can click
on the box on the right-hand side and drag it to the left to re-
size the bars.

Copy and paste to Microsoft Word
Next, we'll select the two-bar melody so that we can copy and
paste it into Microsoft Word.

In Sibelius, go to ‘Edit > Select > Select graphic’. Your mouse
pointer will become a cross-hair and then you can click and
drag a box around the melody to select it. You can adjust the
box around the melody by clicking and dragging any of the
‘handles’.

[+
M

Once you're happy with the way your melody has been
selected, copy it to the clipboard by using the shortcut
Cul+C (Windows) or  3-C (Mac). Open Microsoft Word
and then paste the rhythm into an empty document by using
the shortcut Cerl+V (Windows) or  38-V (Mac).

In Finale, make sure you are in Page View (‘View > Page
View’) and then open the Advanced Tool Palette by going to
“Window > Tools > Advanced Tool Palette’. Select che
Graphics tool and then double-click and drag a dotted-line
box around the two bar melody. Go to ‘Graphics > Export
Selection” and in the dialogue that opens, select a graphic
format type (TIFF would work well for this example) and
save it to an appropriate location. Next, open a blank
document in Word and go to ‘Insert > Picture > From file’,
Locate the image you downloaded, select it and click ‘Insert’.

1 ACTION
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No matter which notation program you’re using, you should

end up with something like this in Word:

| 1
e e
Altering the size of your graphic in Word
Once you've pasted your melody into Word, you can
manipulate it like any other graphic. For instance, click on
the graphic and then re-size it by dragging one of the corner
‘handles’ in or out (dragging one of the middle handles will
distort the graphic, so remember to use only the corner
handles)., You can also experiment with the Wrapping
options in Word (found under ‘Format > Picture’) if you'd
like to use your musical graphic in an essay, worksheet or
exam paper rather than as a flashcard.

You can use the method described above to create Hashcards
for just about anything that can be created in Sibelius or
Finale—from a single note, rest or clef to multiple-bar
rhythms and melodies. Copying and pasting musical
graphics to Word can also be useful for making your own
worksheets, exam papers and tests, and students can employ
the technique to cite musical examples in their essays.

3. Free graphics = instant posters and enhanced
scores

Did you know that there are hundreds of free downloadable
music graphics and photos available on the internet? These
free images can be used to create posters for your classroom,
to add interest to class notes or Powerpoint presentations, or
to enhance your scores and worksheets.

One useful collection of websites is listed at:
www.tinyurl.com.au/x.php?1px7

One word of warning however. There are varying qualitics of
pictures out there. Bookmark any sites that conrain graphics
or photos you like. It’s very easy to get lost in an web-based
sea of images!

Download your chosen image, usually by right-clicking
(Windows) or Control-clicking (Mac) on the image and
choosing the ‘Save As’ option to save it to your hard drive.
It can be a good idea to save the images into a folder with
the title of the website you downloaded it from, so that way
you can easily go back to the original website at a later stage
or cite your source if necessary.

You'll also need to malke sure that you take note of any
Conditions of Use surrounding images you download from
the internet. They will be detailed on the website.

4. Instant posters

Once you've found some images you like, what next? To
make your own posters, open a blank document in Microsoft
Word and go to ‘Insert > Picture > From file’. Locate the
image you downloaded, select it and click Insert. The image
will open in Word and you can re-size it by selecting it and
dragging one of the corner handles out to enlarge the picture,
or in to make it smaller. Remember that re-sizing from the
corners will maintain the proportions of the image. Add a
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title to the picture and print out your free poster for your
classroom wall!

5. Enhanced scores and worksheets

You can also enhance handouts for your class—from scores
containing music examples, to class worksheets that ask
students to idenify musical instruments—by importing
graphics into scores you create in your notation program.
For example, in addition to including the music notation of
the melody, a picture of a violin could be inserted into a
worksheer to illustrate Peter’s theme in Prokofiev’s Peter and

the Wolf.

To add a graphic to your score in Sibelius, go to ‘Create >
Graphic’ and navigate to the graphics file youd like to import
into your score. Sibelius will allow you to import files in a
TIFF format and there is a large selection of images provided
in your Example scores folder (but you can use any other
TIFF file you may have). Once you've selected the image,
your mouse pointer will turn blue and you can click in the
score to place the graphic. When the image is in your score
you can select and move it, or re-size it using the handle in
the corner.

You can do the same thing in Finale by first ensuring that
you're in ‘Page View’ (go to ‘View > Page View'). Select the
‘Graphics tool” and then go to ‘Graphics menu > Place
Graphic’. Locate your image and click ‘Open’. A special
cursor will appear and you can click in the score to place the
graphic. Once the image is in the score you can select it and
move it, or re-size it by double-clicking the image, entering
new percentages under “Scale’, and clicking ‘OK.

So, if you have access to a music notation software program,
why not try out some of these ideas and make full use of its
potential to produce more than just a score! [/

Katie Wardrobe

Katie Wardrobe runs a music technology training
business called Midnight Music, which offers on-site
professional development for teachers and workshops
for students. She also offers services as a copyist and
arranger and has previously worked for Sibelius as
Education and Support Specialist, and as the
Community Program Manager for Orchestra Victoria.




WHEN WILL YOU SEE US AGAIN?

After six years (and 25 issues), Music in Action is accepted as THE only magazine of interest to Australia's
classroom music teachers. It's made possible by advertising, a subsidy by the Australian Music
Association—and your personal subscriptions. Free bulk distribution to schools has to be limited to
contain costs, and is random. Only YOUR PERSONAL SUBSCRIPTION* will ensure that this valuable
resource continues to arrive on your desk, so that news of the work of fellow music educators will sustain
and inspire your own activity.

*Covers postage, handling and admin. costs

TO RECEIVE YOUR OWN PERSONALLY ADDRESSED COPY OF ‘MUSIC IN ACTION'
MAILED DIRECT 4 TIMES A YEAR, FILL IN THE FORM AND MAIL TODAY!

Get the reduced subscription price: only $32.50 for 2 years (8 issues), or $19.90 for 1 year (4 issues)
—up to 40% saving off RRP.

SUBSCRIBE AND GO INTO THE DRAW TO WIN FOR YOUR SCHOOL A

ZOOM H4n PORTABLE DIGITAL RECORDER

Get the choir singing from the same song sheet ... in harmony! Record and archive
those debates and speeches. Record the school band wherever it's playing (with
effects and modelling). From the assembly hall to the science lab to the English
department to the music studio. Record performances and lessons for podcasts.
Two quality inbuilt condenser mics + 2 input jacks for 4-track recording. In-built
reference speaker, tuner and metronome. Hours of recording. WHAT AN ASSET!
Prize generously donated by Dynamic Music

To be in the draw, make sure your subscription order is sent
by 3 July 2009

AUTUMN SUBSCRIBER PRIZE WINNERS The 15 winners of the Classical
Destinations packs are to be found on page 11

| Price includes GST, P&H. Subscriptions commence from the SPRING 2009 issue.
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LOOKING FOR SCHOOLS THAT SING

Teachers, parents and students are being urged to enter their school in the fourth FLAME Awards, Australia’s
nationwide competition being conducted by 'Music.Play for Life' in partnership with the ABC. TINA BROAD
says that this year the Awards are for schools that use singing to build students' engagement and skills in music.

wards judge, Graham Abbott, is an ABC

Classic FM radio presenter and a former
school music teacher. “The FLAME Awards are
run against a backdrop of research which shows
that music education is in decline in many, many
schools in Australia, yet” he says, ‘every child arrives at school
each morning with a musical instrument: a voice. We want to
highlight the schools making the most of that, to inspire
other schools to follow their lead.’

THE

“Whether you're in a big city or a small rural area, if your
school has an innovative music program with singing at its
heart, we'd love to hear about it and reward your success,’
Graham says.

‘Music.Play for Life’ campaign manager, Tina Broad, says that
making music stimulates a child’s physical, emotional and
intellectual development as almost no other activity can. “The
FLAME Awards acknowledge that, and give us the
opportunity to recognise school communities providing their
students with the best start cowards a rich and lifelong
relationship with music’, she says.

The Awards recognise school music programs where
participation and engagement are paramount. ‘If performance
excellence is a by-product of a great, participatory program—
and it should be! —that’s great,” says Tina. ‘But it won't be
the first thing we look for when you tell us abour your
program. How are you getting the maximum number of
students in your school turned on to music? That’s really the
test.”

The Awards are being conducted by ABC Classic FM in
association with ‘Music.Play for Life, the Music Council of
Australia’s national campaign to encourage more music
making in schools and communities. ‘Music.Play for Life’
partner, the Australian Society for Music Education, helps set
the entry criteria and manage the shortlisting process. This

MUSIC in ACTION
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AWARDS

year the $10,000 prize pool is donated by
Sydney philanthropists, Robert and Elizabeth
Albert.

As always, the Awards are open to both
government and independent schools. After a primary-only
theme last time around, this year’s Awards are again open to
primary and secondary schools. The National Winner
receives $3,000 cash and plays host to a live concert staged
and broadcast by ABC Classic FM. Eight state and territory
finalists each win $1,000 for their school music programs,
along with a selection of music CDs and magazine
subscriptions.

The most recent ‘best primary program’ themed Awards were
won by New Farm State School in Queensland, for a
comprehensive music program which drew on the skills and
influences of its local Chinese community. South Australia’s
Tatachilla Lutheran College won the ‘community
connections’ Award in 2006, for an extensive and imaginative
music program that established the school as the hub of
musical life in its community of McLaren Vale. The inaugural
winner, in 2005, was Virginia State School, a 300-student
primary school in the outer suburbs of Brisbane, which
impressed judges with the depth and diversity of its music
program, achieved despite the school’s limited resources. [Minfl

CONTACTS

To download an entry form:
www.abc.net.au/flame or call 02 44 54 3887. The
deadline for entries is 20 July.

For more information: Telephone Emma Paillas,
ABC Classic FM (02) 8333 2697 or
Tina Broad, 0439 022 257.
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M Professional Development

9th Australasian Piano
Pedagogy Conference
* 13-17 July 2009

The King’s School, North
Parramatta, NSW

Details: www.appca.com.au

T: 02 9785 2547

ASME

* 10-14 July 2009

17th National Conference—
Musical Understanding
Venue: Hotel Grand Chancellor,
Launceston, Tasmania

Derails:

www.cdesign.com.au/asme2009

ANZARME

(Australian and New Zealand
Association for Research in Music
Educarion)

® 46 July 2009

13th Annual Conference
Venue: Akaroa, Banks Peninsula,
New Zealand

Details:
www.merc.canterbury.ac.nz &
www.deakin.edu.au/arts-ed
/education/music-ed/anzarme

AUSTA

® 9-14 July 2009

AUSTA National Conference
2009

Venue: Esplanade Hotel,
Fremantle (Perth), WA
Details:

www.austaconf2009.net.au

DALCROZE AUSTRALIA
South Australian chaprer.
Workshop Dates

* 31 May 2009

* 16 August 2009

Highgate Primary School

T: 08 8303 3762 E:
ruth.saffir@adelaide.edu.au

T: 08 8381 4535 E:
rvfudge@iinet.net.au

KODALY

QLD (KMEIA)

° 7-11 July 2009

John Feierabend Workshop on
ECE music & movement
School of Music, University of
Queensland, St Lucia

E: the.willows@bigpond.com

NSW (KMEIA)

* 13-17 July 2009

John Feierabend Workshop on
ECE music & movement
Sydney Conservatorium of
Music

E: acollado@oprusnet.com.au

MUSIC in ACTION

Organisations are invited to list PD events with Music in Action. Events are listed first in

alpha order by organisation, then by date. Listings are compiled from information provided
and may be incomplete or have changed. Please check with the organisations direct. Our
disclaimer on page 4 applies.

VIC (KMEIA)

* 8-9 May 2009

Autumn Seminar

St John’s Southgate, Melbourne

® 24 July 2009

Early Childhood Workshop
No. 3

Music Works Magic, 263
Glenhuntly Rd, Elsternwicl

® 23 October 2009

Early Childhood Workshop
No. 4

Music Works Magic, 263
Glenhuntly Rd, Elsternwick
Details: www.kodaly.org.au
T: 03 9535 7035

Maryborough Music
Conference 2009

* 11-15 July 2009

Brolga Theatre & Convention
Centre, Maryborough, QLD
Details: www.maryboroughmusic
conference.com.au

ORFF

NSW (OSANSW)

TaikOz Japanese Drumming
Workshop

* 31 May 2009

The Ultimo Centre, Sydney
Details: www.orffnsw.org.au
T:'02:9987 2152 E:
rossam@tpg.com.au

SA (OSASA)

* 23 May 2009
Term 2 Conference
Fullarton Park Centre

® 31 July—1 August 2009
State Conference
Fullarton Park Centre
Details: www.osasa.net

VIC (VOSA)

* 14-18 April 2009

VOSA Levels 1 & 2 Courses
Glen Waverley Anglican Church
Hall, Glen Waverley

* 29-30 May 2009

Living Music and Dance 2009
Darebin Arts & Entertainment
Centre, Preston

* 29 June—3 July 2009
Joy of Jammin® Stage 2
Hampton Primary School,
Hampton

* 17-19 July 2009
Marimba Camp
Candlebarlk Farm, Healesville

® 22-23 August 2009

Early Childhood Conference of
Performing Arts

Gennazano FCJ College,
Cotham Rd, Kew

Details: www.vosa.org
T: 03 9535 7020

WA (WAOSA)
* 15 May 2009
As-May Choral Day

* 29-30 May 2009

WAOSA Creative Music and
Movement Conference

All Saints’ College Junior School,
Bull Creek

Details: www.ancos.org.au

Sounds Great 2009 Conference
(Victoria)

* 17-19 July 2009

Presented by a consortium of
Vicrorian music education
associations.

Details: www.soundsgreat.org.au

SOUNDHOUSE
VIC
Alfred Brash SoundHouse

Melbourne

* 7— 8 May 2009
SoundHouse Certificate in
MIDI and Audio
Production with Sonar Home
Studio

* 18 May 2009

Sibelius Level 2a—Worksheets
& Exams

Details:
www.theartscentre.com.au
/soundhouse

T: 03 9281 8194

SoundHouse @ Debney Park
Secondary College
Flemington, Victoria

* 14 May 2009

Podcasting, Vodcasting and
YouTube

* 21 May 2009
Create Music for your Films—
Garageband

* 16 July 2009
Sibelius Level 1

® 30 July 2009
Sibelius Level 2

¢ 6 August 2009
Band-in-a-Box

® 13 August 2009
Groovy Music

® 20 August 2009
Finale Notepad

Details: www.soundhouse.com.au

T: 03 9376 6833

ADVANCE NOTICES
2010

35th Conference of the
International Trumpet Guild

* 6-10 July 2010

Sydney

Details:
www.australiantrumpetguild.com
itg2010

T: 029518 7722

ANCOS National Conference

¢ 3-8 January 2010

Creative Music & Movement—
Creating New Blends
Immanuel College, Adelaide
Details:
www.osasa.net/welcome.htm

T: 03 9593 7020

KMEIA National Conference
® 26-29 September 2010
Melbourne

Details: www.kodaly.org.au

T: 03 9535 7035
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14 characterful pieces for flexible ensemble
By Kathyg and David Blackwell

String Time Joggers is full of great new ensemble material
for all string groups, whatever their size.

@ Flexible scoring for violin, viola, cello, and double bass with
piano or CD accompaniment—from two parts to massed string Violin book with CD
ensemble! 9780193359130

Viola book with CD
9780193359147

Cello book with CD

Teacher's pack

Includes full score, piano
score, notes on the pieces,

@ Pieces may also be played as solos for violin, viola, or cello,
with piano or CD backing

CD with performances, and ~ ® Corresponds to the level of Fiddle/Viola/Cello Time foggers 9780193359154
backing tracks Look and listen to pieces from the String Time Joggers books at Double bass part
9780193359161 www.oup.com/uk/music/stringtime 9780193359703

Kathy and David Blackwell, authors of the highly successful String Time tutors, will be presenting
a series of workshops for string teachers in Brisbane, Sydney, Adelaide, and Melbourne during
July 09. For more information, email music.enquiry.uk@oup.com with the subject ‘Australian
String Time Tour’ telling us your postal address and the stringed instruments you teach.

The leading resource for
successful singing

‘The most significant contribution to improving the teaching
of singing that we have seen in the last 30 years.’

Europa Cantat magazine i
coming soon!

OXFORD

POPULAR :3
VOICEWORKS

David Blackwell, Head of OUP’s Music
Department, will be presenting a series of
workshops on the VOICEWORKS books in
Brisbane, Sydney, Adelaide, and Melbourne
during July 09. For more information, email
music.enquiry.uk@oup.com with the subject
‘Australian Voiceworks Tour’ giving us your
postal address.

Visit the VOICEWORKS website at
www.oup.com/uk/music/educ




LEARN - TEACH - PLAY MUSIC

Email us , register your ematl and mai(éng address and

you il receive a FREE boand score and parts or
strng orchestra score and parts or £ you are a cheral

director we will send you 5 FREE copies of a cheral

prece.

FREE titles are limited so act now to recetve
this incredible offerV In addition you will receive
a discount veucher that You can use at participating
stores.

[ itles and level are determined by Alfred but
please feel free to specity what (evel you would

preter and we will do our best to accommeodate

(N L ——— )
vercusson | (] | TR

Email today - school@alfredpub.com.au
and within 4 weeks you will receive your FHEE score and parts
Offer ends June 30th 2009




